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Chapter 1: Introducing CA GMI 
 

Note: The following software versions were used to create the screen samples and 
examples in this guide: 

■ CAVantage SRM Windows Client Release 12.5 

■ CAVantage SRM Web Client Release 12.5 

■ CAVantage SRM Release 12.5 

This section contains the following topics: 

About CA GMI (see page 7) 
The Object Tree (see page 9) 
Standard CA GMI Features (see page 11) 

 

About CA GMI 

CA GMI is the graphical management interface product that allows you to view and 
manage mainframe activity from a PC. It consists of user-interface clients which 
interface with a z/OS server component to allow access to basic z/OS server functions.  

 

The following user-interface clients are available: 

Windows Client  

This client provides full functionality. That is, you can manually perform view and 
analysis functions, filter and sort desired entries, zoom (drill-down) to related 
objects, and take actions upon selected entries. You can create customized colored 
reports in different formats, for example, tables and graphs in HTML, PDF, and XLS 
formats. These reports can be printed and exported to your PC directory, servers, 
intranet, and so on. The Windows Client has a Scheduler component that manages 
scheduled tasks defined in the Windows Client (for example, tasks scheduled using 
the View and Output Definitions, and Object Logging functions). You can create, 
manage, and view Summary Objects and Joined Objects. This client also provides 
designer wizards to create scripts to monitor and respond to any condition, 
exceptional or routine, in automatic ways. These automation services let you 
replace many manual processes of managing your system. It also has a JCL 
Management feature to manage JCL and includes the Host Config Client which you 
can use to set CAVantage SRM system parameters. 

Note: The Joined Objects feature requires a CAVantage SRM base license and at 
least CAVantage SRM Release 12.5 on the z/OS hosts. Automation services requires 
a CAVantage SRM Automation Option license. 
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Web Client 

As a browser interface, it can be used from any PC with internet access to the Web 
Client’s application server. The current version of the Web Client provides the 
user-driven functionality of view and analysis, filtering and sorting, zooming, and 
the ability to take actions on selected entries. You can create customized colored 
reports in different formats, for example, tables and graphs in HTML, PDF, and XLS 
formats. These reports can be printed and exported to your PC directory, servers, 
intranet, and so on. The Web Client has a Scheduler component that manages 
scheduled tasks defined in the Web Client (for example, you can schedule output 
reports). You can create, manage, and view Joined Objects, and you can view 
Summary Objects.  

Note: The Joined Objects feature requires a CAVantage SRM base license and at 
least CAVantage SRM Release 12.5 installed on the z/OS hosts.  

 

3270-based interface (View 3270 Client)  

This client provides partial functionality. It is limited to the user-driven functionality 
of view and analysis, filtering and sorting, zooming, and the ability to take actions 
on selected entries.   

Note: The View 3270 Client is considered a character-based user-interface, not a 
graphic-based user-interface, so it is not discussed in this guide. For View 3270 
Client installation and configuration information, see the CAVantage SRM 
Configuration Guide. For more information about using the View 3270 Client, see 
the chapter "Navigating the View 3270 Client" in the CAVantage SRM User Guide. 

 

Note: This guide mostly displays examples from the Windows Client, which are similar in 
many respects to the Web Client. For more information about Web Client features, see 
the CAVantage SRM Web Client Guide. 

 

CA GMI is included free of charge with many CA products. The CA GMI components only 
need to be installed once. However, you must configure the z/OS server component for 
each CA GMI enabled CA product you want to use CA GMI for, on each host where you 
want to use it. The following is the list of CA GMI enabled CA products: 

■ CA 1 

■ CA ASTEX  
 

■ CA CREWS  
 

 

■ CADisk 
 

■ CA IDMS/DB 
 

■ CAEncryption Key Manager 
 

■ CA MasterCat 
 

■ CA PDSMAN 
   

■ CA SYSVIEW 
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■ CATape Encryption 
 
 

■ [set the ttm variable for your book] 
 

■ CAVantage SRM  

■ CAVtapeVTS  
 

The Object Tree 

You access all user-interface functions from the main window of the user-interface. The 
Object Tree is a major feature on the main window of the user-interface. 

The expandable and collapsible Object Tree lists all the source objects in a hierarchical 
tree structure. A folder icon represents a grouping of objects in the tree. When you 
expand a folder you will either view subfolders, the objects in the folder, or both. 
Different types of objects are represented by different icons and their title. A source 
object contains all the fields updated by the data collection services for that object. All 
fields-or any subset of them-can be included in user-defined views based on the source 
object. 

 

In the Windows Client, the Object Tree is displayed in its own window. To display the 
Object Tree in the Windows Client, click the Object Tree icon in the Windows Client 
toolbar. The following is a sample of the Windows Client Object Tree window: 
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In the Web Client, the Object Tree is displayed in the GMI Tree navigation pane in the 
Web Client main window. The following is an example of the GMI Tree navigation pane 
in the Web Client main window: 

 
 

You can access CA GMI enabled product objects using the user-interfaces, and the 
following basic CAVantage SRM storage management objects: 

■ CA Vantage Internal Management, which includes the following objects and 
sub-folders: 

– All Summary Objects 

– JCL Model List 
 

– Internal Status Monitor 
 

– Log and Warm Start Status 
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– Sub-folder; Analysis Tools (memory usage, object dictionary, and component 
analysis) 

 

– Sub-folder; System Activity (Message Log, Mailbox, System Parameters, 
Operator Commands, and others) 

 

■ Catalog Management (locations, relationships, entries, and space usage) 
 

■ DFSMS Constructs (all attributes) 
 

■ Hardware Errors (current and historical, and tape units) 
 

■ Storage Groups (space usage and other attributes) 
 

■ Volumes (DASD - space usage and other attributes) 
 

■ z/OS System Resources (APF list, Link list, and so on) 

To find out more about these objects in the Windows Client, right-click the object in the 
object tree and click the Help on Object option. To display the Object Help in the Web 
Client, open the object, click Help, and then Object object_name Help. 

 

Standard CA GMI Features 

CA GMI user-interfaces provide a rich set of standard features for working with your 
products and related object data. These features include the following: 

■ Simultaneous connection to several z/OS hosts, with separate views for each host, 
or all hosts consolidated into a single view  

■ Table views of all data, customizable with the ease of point-and-click 
 

■ Graphical views of any numeric data, easily customized, with a wide range of 
two-dimensional and three-dimensional features 

 

■ Filtering and sorting on any field 
 

■ Summary Totals and Statistics (aggregate functions such as total, average, 
minimum, and maximum) 

 

■ Scaling (KB, MB, GB, and so on) and color coding features 
 

■ Drill-down feature to zoom to related object data 
 

■ Wizards for simple or complex summaries (Summary Objects) 

Note: Currently, you can create and manage Summary Objects using only the 
Windows Client. You can view Summary Objects using both the Windows Client and 
the Web Client. 

 

■ Reporting features for customized and printed reports 
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■ Multiple output formats, including: 

– Web page (HTML) 

– Email 
 

– PDF 
 

– Excel 
 

– Microsoft Access Database (MDB) 

Note: This output format is only available from the Windows Client. 
 

– Comma Separated Values (CSV) 

Note: This output format is only available from the Web Client. 
 

■ Schedulers for producing and sending report output on a regular basis 
 

■ JCL management (edit, model, drag and drop, substitute, submit, and schedule) 

Note: Currently, JCL management is only available in the Windows Client. 
 

The following sections provide examples of some of the standard features of the 
Windows Client: 

■ Standard Object Views (see page 12) 

■ Standard View Options (see page 30) 

■ Other Standard Features (see page 49) 
 

Standard Object Views 

The standard object views in the Windows Client are the Table View, Graph View, and 
List View. The standard object view in the Web Client is the table view and you can 
create charts (graphs) of object information (data).  

The following sections describe the Table View of both clients and the Graph View of the 
Windows Client. 

 

Table Views 

In both the Windows Client and the Web Client, the default view of objects is the Table 
View. The Table View displays object information (data) in configurable tables. You can 
change display characteristics (such as the width and number of table columns, the 
number of rows displayed, and so on) and characteristics that apply to specific objects, 
such as sort and filter criteria. The display and object-specific characteristics determine 
the appearance of the table. When you save your user-defined views of objects, you 
automatically save the display and object characteristics with it. 
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The following is a sample of an object table displayed by the Web Client: 

 
 

The following is a sample of a Table View of an object displayed by the Windows Client: 

 
 

In the Windows Client, you can change the view type, for example from the Table View 
to the Graph View, or List View by clicking the Switch to icon in the bottom left corner of 
the object window, as shown in the sample Table View. In the Web Client, if you have 
created a chart (graphic) view of object data then the chart is displayed above the table. 
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Table View Dialog Toolbar Options 

The Web Client Customize Menu provides access to the Customize View Wizard and the 
Customize Report Wizard. The Customize View Wizard provides object view customize 
options such as: filter, sort, charting (object graphs), hide or display columns, rename 
columns, and so on. The Customize Report Wizard allows you to create and manage 
output reports and output report schedules.  

 

The Windows Client Table View dialog toolbar provides the following options: 

 
 

The Windows Client Table View dialog toolbar icons can vary depending on the object 
being displayed. The following are just a couple of the additional icons that may appear 
depending on the object being displayed: 

View Info Area Icon ( ) 

Displays an information area (Info Area) window that contains information unique 
to the object, or other information related to the entire object.  

Note: To see an explanation of the information displayed in the information area 
window, open the Help About Object online help system from the object's toolbar.  

 

Input List Icon ( ) 

Allows you to specify the input that creates the object. The type of input can vary 
from object to object. In some cases, such as when working with CA Disk archive 
and backup data, the Input List provides the names of one or more data sets from 
which the object data is extracted; that is, the CA Disk FILES Data Sets. In the case of 
the BCS Data Set Entries object (which lists catalog entries), the Input List is a data 
set name or data set name pattern to be found in the system catalogs. For other 
objects, the Input List is an input command to the specific product that produces 
the object.   

 

In most cases, each Input List can be configured to provide system defaults. The 
Input List dialog allows you to override the default values. Click the Help button in 
the Input List dialog to find out how to use the dialog.  
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When the Input List consists of data set names, and GDGs are appropriate, either 
relative or absolute names may be entered. You may also specify System variables 
and System Symbols within the Input List, and their active values will be 
substituted.  

Note: Because an Input List is not executed in any specific object context, you 
cannot use Object Related variables for substitution. 

 

Note: For more information about the Table View dialog toolbar options, see the 
CAVantage SRM Windows Client Guide and the Help About Window online help system. 

 

Additional Table View Options 

In addition to the Web Client menu and toolbar options, you can click the down arrow 
next to a column heading and sort the object table by that column in ascending or 
descending order. You can also click the down arrow next to a column heading and 
specify which columns you want to display or hide. The following is an example of the 
Web Client's Object Column Headings Options menu, where the down-arrow next to the 
% Alloc column heading is selected: 

  

Note: The Web Client Customize View Wizard also provides sort and column display or 
hide options. 

 

In addition to the Windows Client Table View menu and toolbar options you can also 
perform some quick appearance changes to the Table View as follows: 

■ Quick Find in Column 

■ Quick Sort on Columns  
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■ Quick Color Code a Column  
 

■ Move the Freeze Column Line 
 

■ Return a Table View to Factory Settings  

How to perform these changes is explained in the following procedures.  

Note: The following Windows Client options and more options for customizing a view 
are available in the View and Output Definition feature. For more information, see the 
section Customized Reports (see page 42). 

 

To Quick Find in Column 

Instead of scrolling down to a row you can quickly find a particular item. To do this you 
can use the Quick Find in Column option by following these steps: 

1. Right click the column heading which contains the item you want to find. 

The Column Options Menu is displayed as shown in the following sample: 

 
 

2. Click the Find option in the Column Options Menu. 

The Find dialog is displayed. 
 

3. In the Find What field type in the item you want to find. You can type in part of the 
item, for example if you wanted to find ABC123 then you could type in ABC, ABC1, 
and so on. 

 

4. Click Find Next. 

The Table View of the object is updated and the first item containing your find 
criteria is displayed. If the criterion is not found in the column then you will receive 
a message advising it is not found. 
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To Quick Sort on Columns 

You can perform quick sorts in the Table View by clicking a column heading title cell 
and the table will sort by that column in descending order. Click the column heading 
title cell again and the table will sort by that column in ascending order. 

You can also right click a column heading and the Column Options Menu is 
displayed where you can select the Sort Ascending or Sort Descending options. The 
following is a sample of the Column Options Menu: 

 

Note: After you have created a Table View column sort in this manner you may 
want to remove it; to remove a Table View column sort, click the Sort icon and use 
the Exclude a Field option or the Exclude all Fields option. For more information, 
see the section Sort Option (see page 32).  

 

To Quick Color Code a Column 

You can highlight certain values in columns by color coding them when specific criteria is 
met. You have two options for color coding, you can use the Quick Color Code a Column 
option or you can use the View and Output Destination – Fields option (the View and 
Output Destination – Fields option, is described in the section Color Code Option (see 
page 37)).  

To use the Quick Color Code a Column option, perform the following steps: 

1. Right click the column heading of the column you want to color code. 

The Column Options Menu is displayed as shown in the following sample: 
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2. Click the Column Color Coding option in the Column Options Menu. 

The Column Color Code dialog is displayed. The following is a sample of the Column 
Color Code dialog displayed for the Volumes column in the Storage Group Volumes 
object: 

 
 

3. Click in the first empty Condition cell. 

A down arrow appears on the right side of the cell. 
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4. Click the down arrow on the right side of the cell. 

The Condition options are displayed as shown in the following sample: 

 
 

5. Select the condition you want. 

The condition selected is displayed in the cell. 
 

6. Click in the Value cell of the same row you selected the condition. Type in the value 
that you want the condition applied to. 

The value is displayed in the cell. 
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7. Click the Color cell of the same row you selected the condition and typed in a value.  

The Color dialog is displayed as shown in the following sample: 

  
 

8. In the Color dialog select the color you want to appear as the background for the 
items that meet your criteria and click OK. 

The Column Color Code dialog is displayed showing the condition, value and color 
you have specified.  
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The following is an example of the Column Color Code dialog where the condition is 
‘=’, the value is ‘ACFQA1‘ and the color is blue for the Volumes column in the 
Storage Group Volumes object: 

 
 

9. Click OK. 

The Table View of the object is displayed with your color code settings. 
 

10. In the Table View menu select File and then click Save, to save your settings.  

If you save the Table View with the column color code setting then every time you open 
the object the color codes are applied. To remove the column color coding; display the 
object, right click the column, select No Colors, and then click OK in the Column Color 
Code dialog.  

 

Observe the following: 

■ You can apply the color coding to the cells in the column selected or you can apply 
the color coding to the whole row by selecting the Apply to Row option. 

■ You can apply predefined color code values by selecting the Use predefined colors 

button (  ).  
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■ You can save the column color codes you have created so that you can use them 

later by selecting the Store these colors as predefined button (  ).  

■ You can have multiple conditions, values, and colors to the same column. However, 
the Windows Client checks the conditions sequentially until the first match occurs 
and it uses ANSII character sort order for the comparison (for example: 0-9, A-Z, and 
a-z). If one value meets two or more conditions then the first condition is applied. 

 

For example: if you color code two conditions in the dialog such that ‘= AAAA1 Blue’ 
is listed first, and then ‘> AAAA0 Red’ is listed second in the dialog then the 
Windows Client will apply the ‘= AAAA1 Blue’ condition to all AAAA1 items, then it 
will apply the second condition, ‘> AAAA0 Red’, to any items that meets the second 
condition but where the first condition has not been applied. If the conditions are 
reversed in the dialog so that ‘> AAAA0 Red’ is first and ‘= AAAA1 Blue’ is listed 
second in the dialog, then the second condition, ‘=AAAA1 Blue’, would be ignored 
because items with values AAAA1 have already met the first condition and the red 
color coding is already applied to them. 

 

■ There are no "and" or "or" condition statements available for color coding multiple 
conditions, values, and colors to the same column. There are simply the 'less than', 
'less than or equal to', 'equal to', 'greater than', 'greater than' or equal to', 'less than 
or greater than' and ‘Range’ (for numerical fields only) conditions available for 
comparison to the values you specify. 

 

To Move the Freeze Column Line 

You can freeze columns so that when you scroll to the right in a Table View, certain 
columns stay in the view. The black vertical line separating columns is the Freeze 
Column Line. The following illustration shows the factory default Freeze Column Line for 
the Storage Group Volumes object: 
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To include the Type and Volumes columns as Freeze Columns perform the following 
steps: 

Note: You can similarly include as many columns as you want as Freeze columns in any 
Table View of an object. 

1. Click on the vertical line between the SG Name and the Type columns and 
drag-and-drop it to the vertical line between the Volume and the CUA1 columns.  

Note: You must click and drag the line anywhere below the column heading portion 
of the line, that is, it will not work if you click and drag the section of the line 
between the column headings. 

The Freeze Column Line is now displayed between the Volume and the CUA1 
columns as shown in the following sample: 

  

When you now scroll to the right in the Storage Group Volumes object the SG 
Name, Type and Volume columns will always be displayed in the left columns of the 
view. 

  

2. In the object view menu click File and then Save, to save your settings.  

If you save your settings then every time you open the object the Freeze Columns 
line will be where you saved it. Alternatively you can just close the Table View 
without saving your Freeze Column Line change and the next time you open the 
Table View for the object the Freeze Column Line will be where it was with the 
factory setting. 
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To Return a Table View to Factory Settings 

Before you return an object view to factory settings note the following: 

■ By following this procedure you will erase all your settings in the view of the object, 
for example the Sort settings, Column Color Coding settings, Freeze Columns 
settings, Filter settings and so on.  

■ If you only want to remove a particular setting but not all your customized settings 
then open the tool option for the setting you want to remove and remove it. The 
following are a few examples of how to remove particular settings: 

– To remove column color code settings, open the Color Coding dialog for the 
column colors you want to remove and select No Colors.  

 

– To remove a filter, open the Filter dialog and click the Clear icon (  ) then 
Save. For more information, see the section Filter Option.  

 

– To remove your Freeze Columns settings, move the Freeze Columns line to the 
dividing line between the first and second column.  

 

– To remove column sorts, click the Sort icon ( ) and use the Exclude a Field 
option or the Exclude all Fields option. For more information, see the section 
Sort Option. 
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To return an object view to factory settings, perform the following steps: 

1. Right click the object in the Object Tree.  

The Object Options Menu is displayed. The following shows a sample of the Object 
Options Menu: 

  
 

2. Click Return to Default Settings. 

A confirmation dialog is displayed.  
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3. Click Yes. 

All the changes to the object that you have previously saved will now be replaced 
with factory default settings. You will see this change the next time you open the 
object. 

 

Graph Views 

The Graph View feature displays a selected set of object data in a graph.  

Note: For Web Client users; the Customize View Wizard in the Web Client provides 
Charting options. These options allow you to create charts (graphs) of object data. For 
more information, see the CAVantage SRM Web Client Guide. 

The Windows Client offers a large variation of graph types to present your data in a 
variety of formats. Some of the available graph types are: 

■ Line 

■ Point 
 

■ Area-curve 
 

■ Bar 
 

■ Pie 
 

■ Doughnut 
 

■ Pyramid 

■ Cube 

You can specify the graph type and its format to obtain the kind of display you prefer. 
You can preview the general look of a graph while defining its various features. 

 

Note: To immediately view certain changes, you must click the Refresh icon ( ). 
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The following is a sample of the Windows Client Graph View of the Storage Groups 
object:  

 
 

Graph View Dialog Toolbar Options 

The Windows Client Graph View dialog toolbar provides the following options for 
working with graphs: 

 

Note: For more information about the Graph View dialog toolbar options, see the 
CAVantage SRM Windows Client Guide and the Help About Window online help system.  

 

Additional Graph View Options 

In addition to the Windows Client Graph View menu and toolbar options you can also 
perform some quick appearance changes to the Graph View as follows: 

■ Increase or Decrease Number of Items Displayed 

■ Quick Gallery Option (to change graph type) 
 

■ Quick Color Option (to change graph color) 
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■ Quick Multiple Colors Option 

How to perform these changes is explained in the following procedures.  

Note: The following options and more options for customizing a view are available in 
the Windows Client View and Output Definition option. For more information, see the 
section Customized Reports (see page 42). 

 

Increase or Decrease Number of Items Displayed 

When you switch the object view from Table View to Graph View by clicking the 
Graph icon in the bottom left corner of the view, the Graph View will display the 
same amount of items that were displayed in the Table View. For example, if the 
Table View displayed 8 rows of X records found then the Graph View will display 
only those 8 items. If you want the Graph View to display more items then switch 
back to the Table View and expand the window to display more rows. Then when 
you switch back to the Graph View it will display the same amount of items. For 
example, if the Table View displayed 8 rows and you expand the Table View to 
display 10 rows then when you switch to the Graph View it will display 10 items.  

 

You can also use the Sort Option and the Filter Option in order to specify the order 
of the items and reduce the amount of items you want to display in the graph, prior 
to switching to the Graph View. 

Note: When you print a Graph View, all records (not only the ones displayed in 
Graph View on your screen) will be included in the printout unless you specify a 
range in the print option. 

 

Quick Gallery Option to Change Graph Type 

When a Graph View is displayed you can use the Quick Gallery option to change the 
graph type. (This option is the same as the Gallery icon option found on the Graph 
View toolbar, this is another method for initializing the same option.)  

To use the Quick Graph Type Change option 

1. Right click in the graph of the Graph View. 

The Graph Options Menu is displayed as shown in the following sample: 

 
 

2. Click the Gallery option and a list of graph types is displayed as shown in the 
following sample: 
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3. Click on the graph type you want to change to. 

The Graph View is updated and the new graph type selected is displayed. 
 

Quick Color Option to Change Graph Colors 

When you switch to the Graph View, all the bars will have the same color. To apply 
different colors to the bars you must first use the Quick Multiple Colors Option. 
Then you can right click a particular bar and specify a color for that bar. The 
following procedure assumes you have the object displayed in the Graph View and 
all the bars have the same color. 

To use the Quick Graph Color option to specify a color 

1. Right click on a particular item (for example a bar) in the graph. 

The Graph Options Menu is displayed as shown in the following sample: 

 
 

2. Select the Multiple Colors option. 

The Graph View is displayed and the graph items are displayed by a different 
color.  

 

3. Right click on the item (for example a bar) in the graph you want to specify a 
color for. 

The Graph Options Menu is displayed. 
 

4. Click the Color option. 

A color chart is displayed as shown in the following sample: 

 
 

5. Click on the color you want the item changed to. 

The item in the Graph View is displayed with the color selected. 
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Quick Multiple Colors Option 

When you switch to the Graph View, all the bars will have the same color. To apply 
different colors to the bars you can use the Quick Multiple Colors Option. Then you 
can right click a particular bar and specify a color for that bar as described in the 
section Quick Color Option. The following procedure assumes you have the object 
displayed in the Graph View and all the bars have the same color. 

To use the Multiple Colors Option 

1. Right click on any item (for example a bar) in the graph. 

The Graph Options Menu is displayed as shown in the following sample: 

 
 

2. Click the Multiple Colors option. 

The Graph View is updated with each item displayed by a different color. 

Note: To return the Graph View so that all items use the same color, right click 
an item (for example a bar) in the graph and select the Multiple Colors option. 

 

Standard View Options 

In both the Windows Client and the Web Client, each standard view of object data 
provides options you can use to manipulate object information so it is presented the 
way you like. Some of the more common Windows Client options are described in the 
following sections.  

Note: For more information about these options in the Web Client, see the CAVantage 
SRM Web Client Guide. 

 

Filter Option 

The Filter feature narrows the amount of object information (the number of rows) 
displayed in the table. The Windows Client lists the object fields in the Filter dialog in 
alphabetical order by field name. The Filter dialog guides you in the process of defining 
the filter expression by enabling and disabling the appropriate fields and controls at 
every step. 

Note: For Web Client users; the Customize View Wizard in the Web Client provides a 
similar filtering feature. For more information, see the CAVantage SRM Web Client 
Guide. 
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Example: Create a Filter 

The following Windows Client example shows the filter criteria that would produce a 
user defined view showing only the CAVantage SRM messages issued in the last 3 days. 
In the example a relative date of TODAY-3 is used instead of an absolute date. A relative 
date allows for reuse of the filter without you having to calculate and update the date. 
However you can use absolute dates (specific dates). 

 
 

Filter Dialog Toolbar Options 

The Windows Client Filter dialog toolbar provides the following options: 

 
 

How Filters Work 

A filter can be built from the fields of the object by combining them into Boolean 
expressions. You can also use expressions that contain patterns with wildcard 
characters. 

You can refine your filter by using the AND/OR logical operators to combine several 
expressions. Use parentheses to group sub-expressions. 
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You can enter a filter expression directly into the text box at the bottom of the Define 
Filter dialog or use the typing aids in the dialog. It is possible to edit any expression in 
the text box. 

 

Observe the following: 

■ For more information about how filters work click the Help icon in the Filter dialog. 

■ To immediately view the effect of your filter you must click the Apply and Refresh 

Data icon ( ). 
 

Sort Option 

The Sort feature sorts the table by the values in the columns of the table. Every object 
attribute (or field for z/OS) in a table can serve as a sort key. You can use the Windows 
Client Sort Dialog to sort object data in both the Table View and the Graph View. 

Note: The Customize View Wizard in the Web Client provides a similar sort feature. For 
more information, see the CAVantage SRM Web Client Guide. 

 

The following is a sample of the Windows Client Sort dialog for the POOLS object. It 
points out how to include and exclude fields the object view is sorted by. 

 
 

To change the Sort order using the Windows Client Sort dialog 

1. Double-click the Sort Order icon ( ) in the Sort Order pane of the Sort dialog. 

The Ascending Sort Order icon ( ) appears. 
 

2. Double-click the Sort Order icon again in the Sort Order pane of the Sort dialog. 

The Descending Sort Order icon ( ) appears. 

Note: To immediately view the effect of your sort you must click the Apply and Refresh 

Data icon ( ). 
 

You can sort object data by columns directly in the Table View. 
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To sort the Table View by columns in the Windows Client 

1. Click the column title you want the object data to be sorted by. 

The first time the column title is clicked the table is updated and sorted in 
ascending order by object data in that column. 

 

2. Click the column title again to change the sort to descending order. 

The table is updated and sorted in descending order by object data in that column. 

After you have created a Table View column sort in this manner you may want to 

remove it; to remove a Table View column sort, click the Sort icon ( ) and use the 
Exclude a Field option or the Exclude all the Fields option. 

 

Sort Dialog Toolbar Options 

The Windows Client Sort dialog toolbar provides the following options: 

 
 

Summary Totals and Statistics 

The Windows Client Totals and Statistics Summary options in the View menu let you 
request the total of every numeric field, or combine the totals with the average, 
minimum, and maximum values. 

Note: The Statistics option in the View menu of the Web Client provides a statistics and 
totals view of the object. For more information, see the CAVantage SRM Web Client 
Guide. 
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Example: Access Summary Totals and Statistics options 

The following example shows where to access the Summary Totals and Statistics options 
from the Windows Client View drop-down menu option in the Table View. 
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Totals Option 

The Totals option provides the sum of all numeric fields, as shown in the following 
sample Windows Client Totals dialog. 

 
 

Statistics Option 

The Statistics option provides totals plus the average, minimum, and maximum values 
for all numeric fields, as shown in the following sample Windows Client Statistics dialog. 
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Scale Option 

The Scale option list lets you select the scale base units for displaying numerical data. 
The difference between requesting K, M, G, and so on, as opposed to KB, MB, GB and so 
on is that those with the appended B mean multiples of 1024, while those without the B 
mean multiples of 1000. For example: 

■ nnK = nn(1000), nnM = nn(1000)(1000), and so on. 

■ nnKB = nn(1024), nnMB = nn(1024)(1024), and so on. 

Note: The Customize View Wizard in the Web Client provides a similar field scaling 
feature. For more information, see the CAVantage SRM Web Client Guide. 

 

To scale a column of numeric data in the Windows Client  

1. Click the Definitions icon ( ) on the Windows Client toolbar of the object view. 

The View and Output Definition dialog appears. 
 

2. Click the Fields option in the left navigation pane of the View and Output Definition 
dialog. 

The Fields dialog appears.  
 

3. Click the cell in the Scale column of the Field row for which you want to establish 
the scale for. 

A scale options list appears as show in the following sample: 
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4. Select the scale you want to use. 

The scale selected appears in the cell in the Scale column of the Field. 
 

5. Click OK. 

The View and Output Definition dialog closes and the object view is updated with 
the scales selected. The column heading displays the scale after the heading title, 
for example if you selected a scale of GB for Free Bytes the column heading title will 
indicate the scale is GB and would look like the following sample in your object 
view: 

 
 

Color Code Option 

The Color Code option lets you set conditions for color coding values in object Table 
Views. 

Note: The Customize View Wizard in the Web Client provides a row and field coloring 
feature. For more information, see the CAVantage SRM Web Client Guide. 

 

To color code values in object views in the Windows Client  

1. Click the Definitions icon ( ) from the toolbar of the object Table View. 

The View and Output Definition dialog appears. 

2. Click the Fields option in the left navigation pane of the View and Output Definition 
dialog. 

The Fields dialog appears. 
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3. Click in the Color cell for a field you want to assign a background color. 

The Color Coding dialog appears. The following Color Coding dialog sample shows 
how you can select a condition, enter a condition value, and then select a 
background color for the item that meets the condition. 

 
 

4. Complete the Color Code dialog. 

The condition, value, and color code you selected are displayed in the Color Code 
dialog. 
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5. Click OK in the Color Code dialog. 

The Color Code dialog closes and the Graph icon ( ) appears in the Color cell in the 
Fields dialog, as shown in the following sample. 

 
 

6. Click OK. 

The View and Output Definition dialog closes. The object Table View appears with 
backgrounds of values that meet your conditions color coded. 

 

Open Zoom Option (DrillDown Feature) 

The Windows Client Open Zoom feature provides you with a list of objects that have 
related information. You can select an object from the Zoom list dialog to view the 
related information. 

Note: The Web Client provides a Zoom feature on the Object toolbar. For more 
information, see the CAVantage SRM Web Client Guide. 

To zoom to related objects in the Windows Client  

1. Select a row in the object Table View. 

The selected row is highlighted. 
 

2. Click the Open Zoom icon ( ). 

The Zoom list dialog appears, listing related objects. 
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3. Click an object in the Zoom list. 

Object information in the object selected for that item appears. 

The following sample illustrates a zoom from a particular Volume in the Volumes object 
to the same Volume in the Data Set Name Blocks (DSNBs) object. 

 
 

New Summary Objects Option 

The Windows Client Summary Designer helps you create new summary objects from any 
source object. You select the method for defining the summary groups and select the 
fields to include in the summary object. The summary object includes summary groups 
from a source object table, and then provides statistics about all the object rows that 
fall into each summary group. The statistics include counts, maximum values, minimum 
values, average values, and totals. These statistics are provided for each group of 
records and for all the records. 

You can start the Windows Client Summary Designer two ways, from the object pop-up 
menu or from the Object view Menu Bar. 

Note: Currently, you cannot create or manage Summary Objects using the Web Client. 
You can view Summary Objects using the Web Client.  

 

To start the Windows Client Summary Designer from the object pop-up menu 

1. Right-click on the object in the Object Tree view. 

The Object pop-up menu appears. 
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2. Select New Summary Object in the Object pop-up menu. 

The Summary Designer appears. 
 

To start the Summary Designer from the object view Menu Bar 

1. Click the object in the Object Tree view. 

The object view appears. 
 

2. Select View, then New Summary Object from the object view Menu Bar. 

The Summary Designer appears. 
 

The following is a sample of the Summary Designer. 

 

Note: For more information about how to use the Summary Designer to create a new 
Summary Object click the Help icon in the Summary Designer dialog, or see the chapter 
"Working with Generalized Summary Objects" in the CAVantage SRM User Guide. 
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Customized Reports 

You can customize reports with the appearance and information you want by using the 
Windows Client View and Output Definition feature. 

Note: The Customize Reports Wizard in the Web Client provides an output report 
feature you can use to create and manage user-view object data output reports and 
schedules for output reports. For more information, see the CAVantage SRM Web Client 
Guide. 

The Windows Client View and Output Definition feature allows you to define: 

■ The z/OS hosts from which data is to be retrieved. 

■ The fields (columns) to be included in the report. 

■ The order of the fields (columns) displayed in the report. 
 

■ The sort, color, and scale of the data in the report. 
 

■ The layout design, contents, and record range of the report. This includes the 
grouping of the fields (columns) displayed in the report (using the Grouping facility 
in this feature). 

 

■ The report format (print, web publishing, email, PDF, HTML, XML, TXT, Excel, FTP 
Server, and so on). 

■ The destination of the report (the printer, the directory, web server, email address, 
FTP server ID, and so on). 

 

To start the View and Output Definition feature in the Windows Client  

1. Click the object in the Object Tree view. 

The object view appears. 
 

2. Click the Definitions icon ( ) from the toolbar of the object view. 

The View and Output Definition dialog appears. 
 

Example: Define fields to be displayed in a Storage Groups report 

You can create a report based on the Storage Groups object that contains information 
on the SG Name, Type, % Allo, Vol Cnt, Capacity Bytes, Allocated Bytes and Free Bytes. 
You can then sort the report by descending % Allo. 
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The following example shows how you would define this report in the Windows Client 
View and Output Definition>View>Fields dialog. 

 

Note: For more information about the View and Output Definition dialog, click the Help 
icon in the View and Output Definition dialog. 

 

Multiple Output Formats 

You can use the Windows Client Output Report feature to define output formats, 
schedules, and destinations of your object view as it is currently displayed. When you 
select Destinations in the Output Report feature, you can indicate the format of the 
report and where you want a report to be published.  

Note: The Customize Reports Wizard in the Web Client provides a output report feature 
where you can define output formats, schedules, and destinations of object user-view 
data. For more information, see the CAVantage SRM Web Client Guide. 

When using this feature in the Windows Client, the output includes all the information 
from your object view as it appears in your object view at the time you generate the 
report. Before you generate the report, you can use other object view options (such as 
filter, sort, color code, and so on) to design how the information appears in your object 
view and subsequently how the report appears. The number of records in the report 
depends on the Record Range settings. You also have the option of using the View and 
Output Definition feature to customize reports with the appearance and information 
you want. 
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To start the Output Report feature in the Windows Client  

1. Click the object in the Object Tree view. 

The object view appears. 

2. Select File, then Output Report from the object view menu. 

The Output Report dialog appears. 

The following is a sample of the Windows Client Destinations dialog of the Output 
Report feature for the Storage Group object. 

 

Each output destination gives you additional options as shown in the following example 
procedure for creating a Formatted File. 

 

To produce a Formatted File using the Output Report feature 

1. Click the box next to the File (PDF, HTML, XML, TXT) option in the Destinations 
dialog. 

A check mark appears in the box next to the File (PDF, HTML, XML, TXT) option and 
the Define file location link is highlighted. 
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2. Click the Define file location link.  

The Output Action>Destinations>File (Formatted Report Destinations) dialog 
appears with PDF (Adobe Acrobat) format selected as shown in the following 
sample. 

 
 

3. Click the box next to the formats of the report you want to create and you can click 
the box next to PDF (Adobe Acrobat) option if you do not want to create a PDF file. 

The File: field is populated with a default location dependant on the formats 
selected. 

 

4. Click the Browse button next to the File: field if you want to change where the 
report is to be filed. 

The File: field is populated with the new file location. 
 

5. Click Perform. 

The Output Action>Destinations>File (Formatted Report Destinations) dialog closes, 
and the file is created and filed in the location indicated. 

Note: For more information about the Output Report dialogs, click the Help icon in the 
Output Reports dialog. 
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Print Report Option 

You can quickly print an object view using the Windows Client Print Report icon ( ) 
from the toolbar of the object view. 

Note: The Customize Reports Wizard in the Web Client provides a output report feature 
with output report options. You can then print the output report as you would any 
report. For more information, see the CAVantage SRM Web Client Guide. 

When using this Windows Client feature, the output includes all the information from 
your object view as it appears in your object view at the time you generate the report. 
Before you generate the report, you can use other object view options (such as filter, 
sort, color code, and so on) to design how the information appears in your object view 
and subsequently how the report appears. The number of records in the report depends 
on the Record Range settings. You also have the option of using the View and Output 
Definition feature to customize reports with the appearance and information you want. 

 

To quickly print an object view using the Print Report icon in the Windows Client  

1. Click the object in the Object Tree view. 

The object view appears. 
 

2. Click the Print Report icon ( ) from the toolbar of the object view. 

The Output Action>Record Range dialog appears as shown in the following sample. 

 
 

3. Indicate how many rows of information you want printed. 

The number of rows you want included is indicated. 
 

4. If you have defined a default printer in your Windows operating system and you 
want the print file sent to that printer click the Perform button. 

The Output Action>Record Range dialog closes and the print file is sent to your 
default printer. You do not need to perform any more of the following steps. 
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5. If you want to indicate the printer you want the report sent to click the Next button. 

The Output Action>Destinations dialog appears. 
 

6. Click the Define the printer link 

The Output Action>Destinations>Printer dialog is displayed as shown in the 
following sample: 

 
 

7. Click the down arrow at the end of the Printer field and select the printer you want 
the report sent to. 

Note: The Printer drop-down list includes all printers you have defined in your 
Windows operating system printer setup. 

The printer name selected appears. 

You can also use the Output Action>Destinations>Printer dialog to indicate number 
of copies, page orientation, and paper size. 

 

8. Click Perform. 

The Output Action>Destinations>Printer dialog closes and the print file is sent to 
the printer. 

Note: For more information about the Output Report dialogs, click the Help icon in the 
Output Reports dialog. 
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Mail Report Option 

You can email an object view report in PDF, HTML or Excel format using the Windows 

Client Mail Report icon ( ) from the toolbar of the object view. 

Note: The Customize Reports Wizard in the Web Client provides an email output report 
option. For more information, see the CAVantage SRM Web Client Guide. 

When using this Windows Client feature, the output includes all the information from 
your object view as it appears in your object view at the time you generate the report. 
Before you generate the report, you can use other object view options (such as filter, 
sort, color code, and so on) to design how the information appears in your object view 
and subsequently how the report appears. The number of records in the report depends 
on the Record Range settings. You also have the option of using the View and Output 
Definition feature to customize reports with the appearance and information you want. 

 

To quickly mail an object view using the Mail option in the Windows Client  

1. Click the object in the Object Tree view. 

The object view appears. 
 

2. Click the Mail Report icon ( ) from the toolbar of the object view. 

The Output Action>Record Range dialog appears. 
 

3. Indicate how many rows of information you want included in the attachment 
report. 

 

4. Click Next. 

The Output Action>Destinations>e-Mail dialog appears with the box next to e-Mail 
checked and the Define mail addressee link highlighted. 
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5. Click Next. 

The Output Action > Destinations>e-Mail dialog appears as shown in the following 
sample: 

 

Note: If you have defined a Mail to Address in the Global Options feature then that 
defined email address will be displayed in the Output Action> Destinations>e-Mail 
dialog. 

 

6. Provide the email address, subject, body text to be included in the email, and file 
format of the attachment object view report, then click Perform. 

The Output Action> Destinations>e-Mail dialog closes. An email is created and sent 
with the object view report attached. 

Note: For more information about the Output Report dialogs, click the Help icon in the 
Output Reports dialog. 

 

Other Standard Features 

In addition to object views and related view options there are many additional standard 
features provided with both the Windows Client and the Web Client. These additional 
features can be found on the main window Menu Bar or Toolbar.  

Windows Client 

Windows Client additional features are explained in more detail in the CAVantage 
SRM Windows Client Guide and the Windows Client Help About Window online help 
system.  
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Web Client 

The Web Client also provides a Scheduler feature. End-users can create output 
report schedules using the Customize Reports wizard. Schedules and scheduled 
items can be managed using the Schedule Status feature found in the Tools menu. 
The Web Client Scheduler currently does not provide a JCL Management feature. 
The Web Client Scheduler feature is explained in more detail in the CAVantage SRM 
Web Client Guide and the Web Client Navigation online help system. 

The following sections give a short explanation to the Windows Client Scheduler and JCL 
Management features. 

 

Scheduler 

Both the Windows Client and the Web Client have Schedulers. The Schedulers provide a 
consistent set of scheduling services for all output activities within the user-interfaces. 
You can schedule events by month, week, day, hour, and minute. 

For example, suppose you wanted to be kept up to date on the scratch status of 
volumes by displaying a daily report on your web site. To do this, you could schedule a 
report based on the Volumes object to run every morning at 9:00 AM and set the 
Destination of the report to Web Publishing in the Windows Client, or Publish to Web in 
the Web Client. With this setup, the user-interface automatically runs a report on 
current volume activity every morning and publish the web report on your web server. 

Note: For more information about Web Publishing using the Windows Client, see the 
CAVantage SRM Windows Client Guide. For more information about publishing reports 
to a web server using the Web Client, see the CAVantage SRM Web Client Guide. 

 

Both the Windows Client and the Web Client have Start Scheduler and Stop Scheduler 
options found under their Tools options. And the Windows Client has the Schedule List 
option and the Web Client has a Schedule Status option found under their Tools options 
which you can use to manage the different user-interface's scheduled items.  

The Windows Client also has the Start Scheduler icon and the Schedule List icon in the 
Windows Client main menu Toolbar. 

 

The following is an example of the Web Client Scheduler Status Window displayed when 
you select the Schedule Status option in the Tools menu: 
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The following is a sample of the Windows Client Schedule List window that is displayed 
when you select the Schedule List option: 

 
 

Schedule List Dialog Toolbar Options 

The Web Client Scheduler Status Window provides the following options: 

Run  

Runs the selected scheduled activities immediately.  

Edit  

Modifies a Schedule. 
 

Enable/Disable  

Enables or disables the selected schedules.   
 

Export to Excel  

Exports the information displayed in the Activity List table. 
 

Refresh  

Refreshes the information displayed in the Activity List table with the latest data 
from the web application database. 

Note: For more information about the Web Client Scheduler Status Window, see the 
CAVantage SRM Web Client Guide. 

 

The Windows Client Schedule List dialog provides the following toolbar options: 
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Note: For more information about the Scheduler and Schedule List, see the CAVantage 
SRM Windows Client Guide and the Help on Windows online help system. 

 

JCL Management 

You can submit jobs manually from the Windows Client, either immediately or at a 
scheduled time. When you create a job (JCL stream) to submit, you determine the type 
of job being submitted, the number of steps, and so on. The job can involve your CA 
GMI enabled CA product, standard IBM utility programs, your own utility programs, or 
any combination of these. You can also use IEFBR14 jobs for testing purposes. 

Note: Currently, the Web Client does not have a JCL Management feature. 

The Windows Client helps you specify substitution variables (symbolic parameters) in 
the sample JCL you provide, allowing you to create generalized model JCL. 

 

CA GMI provides two options for managing your JCLs: 

■ The Member Editor (Submit) function 

■ The JCL Model List feature 
 

The Member Editor (Submit) Function 

The Windows Client Member Editor (Submit) function under the z/OS menu in the Main 
Window can be used to manage your JCLs. You can use it to specify substitution 
variables (symbolic parameters) in your sample JCLs. It has a drag-and-drop feature that 
allows you to drag rows from object displays and drop them onto a JCL template in the 
Edit dialog. When you drag and drop the rows, the variables from the rows are 
substituted into the template. You can also use the Member Editor (Submit) function to 
submit jobs manually, either immediately or at a scheduled time. 

Note: Currently, the Web Client does not have a Member Editor (Submit) function. 
 

The following is a sample of the Windows Client New PDS Member Editor dialog that is 
displayed when you select the Member Editor (Submit) function under the z/OS menu 
option. 
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PDS Member Editor Dialog Toolbar Options 

The PDS Member Editor dialog provides the following toolbar options: 

 

Note: For more information about PDS Member Editor options, click the Help icon on 
the PDS Member Editor dialog Toolbar. 

 

The JCL Model List Feature 

The Windows Client JCL Model List feature helps you manage JCL. The JCL Model List 
feature provides the same functionality as the Member Editor (Submit) function 
however it presents your JCL working environment (the Object Table, the Associated JCL 
Members, the Substitution Variable List, and the PDS Member Editor) in one window so 
that working with your JCL is much easier. 

Note: Currently, the Web Client does not have a JCL Model List feature. 

You can use the Windows Client JCL Model List feature to select JCL models to be used 
by objects or a group of objects using pattern matching. These models can be used to 
perform actions or mainframe management functions in batch jobs. The models can 
contain object variables that are substituted upon request or at submit time. 

 

You can start the JCL Model List feature two ways, from the Object Tree Pop-up Menu 
or from the object view Toolbar.  

 

To start the JCL Model List feature from the Object Tree pop-up menu in the Windows 
Client  

1. Right-click an object in the object tree. 

The Object Tree pop-up menu appears. 

2. Click the JCL Model List option. 

The JCL Model List dialog appears. 
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To start and use the JCL Model List feature from the object view Toolbar 

1. Click the object in the object tree. 

The Object view appears. 

2. Click the down arrow next to the Definitions icon in the object view Toolbar. 

The Definitions drop-down menu appears. 
 

3. Click the JCL Model List option. 

The JCL Model List dialog appears. The JCL Model List dialog displays the object data 
and the list of JCL members associated with that object in separate panes as shown 
in the following sample: 

 

The Object Table pane displays the object selected. You can use the object view 
menu options in the pane to change the object view, such as sort, filter, zoom, and 
so on. 

 

The Associated JCL Members pane displays the JCL models you have created and 
linked to the object selected. You can use the Associated JCL Members Action 
options to modify the JCL Model information displayed in the pane, add new JCL 
models, and to delete JCL Models. 

Note: For more information about the Associated JCL Members pane, click the 
menu bar Help option and select Help About Object. 
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4. Double-click a model line, and two additional panes appear in the JCL Model List 
dialog; the Substitution Variable List for the object, and the PDS Member Editor 
with the model JCL. 

The following sample shows how the JCL Model List displays all 4 panes in the JCL 
Model List dialog. 

 

Using the PDS Member Editor pane you can edit the model JCL, create new JCL 
Models, insert variables, substitute variables with object information, submit the 
JCL, and so on. 

Note: For more information about PDS Member Editor options click the Help option 
on the PDS Member Editor pane Menu Bar. 

 

5. Click your cursor in the JCL in the PDS Member Editor pane where you want a 
variable to be inserted, and then double click the desired variable in the 
Substitution Variable List pane. 

The variable appears in the PDS Member Editor pane where you indicated. 
 

6. Repeat step 5 until you have included all your variables in the PDS Member Editor 
pane. 

Now you are ready to substitute the variables in your JCL with object line 
information. 

 

7. Click a line or multiple lines in the Object Table pane, then drag-and-drop them into 
the PDS Member Editor. 

When you do this, a new PDS Member Editor dialog is opened with the resulting 
JCL; that is, the field values from your selected object table lines are substituted 
into the variable locations in a copy of your JCL model in a new PDS Member Editor 
dialog. 

 

8. Click the Submit icon in the PDS Member Editor Toolbar when your JCL is complete 
and you are ready to submit it.  

A message dialog appears advising that your JCL has been submitted. 

Note: For more information about working with the JCL Model List, see the CAVantage 
SRM User Guide. 
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User-Interface Object Action Options 

The Actions option is only available for certain objects and it is used to perform actions 
on specific object items. The actions available for an object relate to specific 
functionality of the object being accessed. 

Note: If the Windows Client Help on Object or the Web Client Object-object_name-Help 
for an object lists Actions, but the Actions menu option does not display any Actions, it 
is because your CA GMI license does not authorize you to use them. 

 

Example: Display of the Action menu of the Volume Space Usage object 

The following is a sample of the Volume Space Usage object Action menu displayed in 
the Web Client: 
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The following is a sample of the Volume Space Usage object Action menu displayed in 
the Windows Client: 

 

Note: When object actions are performed, security checks are made with the proper 
access levels. The user ID for each security check will be either the user ID associated 
with the CA GMI started task, or the user ID that owns the script (the person who 
created or last modified it). For more information about the security system, see the 
description of system parameter SECURSCR in the CAVantage SRM Configuration Guide. 

 

Display Actions Dialog Feature 

You can use the actions dialog feature to perform actions on certain objects. 

To start the Actions dialog feature 

1. Click an object in the Object Tree. 

An object in Table View appears in your user-interface window. 

2. Select a line or group of object data in the object Table that you want to perform 
the action on. 

The line or lines of object data in the Table View is selected. 
 

3. If you are using the Windows Client, click Actions in the Table View Menu Bar. If you 
are using the Web Client, click Actions in the object Menu Bar. 

The Actions drop down list appears. 
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4. Click the Action you want to perform. 

The Actions dialog appears. 

Note: For more information about how to use the Actions dialog view the Help on 
Window online help system in the Windows Client or the Navigation online help system 
in the Web Client. For more information about an object and available object actions 
view the Help on Object online help system in the Windows Client or the 
Object-object_name-Help online help system in the Web Client. If the Help on Object for 
an object or the Object-object_name-Help online help system lists Actions, but the 
Actions menu option does not display any Actions, it is because your CA GMI license 
does not authorize you to use them. 

 

User-Interface Online Help Systems 

Both the Web Client and the Windows Client have two types of online help systems: 

Windows Client 

Help on Window (Help About Window) 

Provides information on how to use Windows Client features and if you click 
Help About Window from a window or dialog Help menu option it provides 
help about the opened window or dialog. This online help system also has a 
search facility. 

Note: From the object tree this help is called Help on Window and when you 
have a window open and you click the Help menu option this is called Help 
About Window. 

 

Help on Object (Help About Object) 

Provides object specific information. It includes a description of the object, 
actions available, and information about the object data fields in the object. 

Note: If the Help on Object for an object lists Actions but the Actions menu 
option does not display any Actions it is because your CA GMI license does not 
authorize you to use them. 

Note: From the object tree, this help is called Help on Object, and when you 
have the object open in a window and click the Help menu option, this is called 
Help About Object. 

 

To access the Windows Client Help on Window (Help About Window) online help 
system 

1. Click the Help icon ( ) displayed in an open window or dialog.  

The help topic that pertains to that window or dialog is displayed. 

Most windows and dialogs also have a Help menu option where you can select 
Help About Window to display the help topic that pertains to that window or 
dialog is displayed. 
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You can also open this online help system from the main Windows Client menu 
by clicking the Help menu option and selecting CA SRM and CA Vantage Help 

Topics or by clicking the Help icon ( ) in the main Windows Client toolbar. 
 

To access the Windows Client Help on Object (Help About Object) online help system 

1. Right-click on an object in the Object Tree dialog. 

The Object pop-up menu appears. 
 

2. Click Help on Object.  

The Help on Object system appears showing the help page related to the object 
selected as shown in the following sample of the Help on Object for the Storage 
Groups object. 

 
 

Example: Display help from an object view 

You can also access the Help on Object (Help About Object) and the Help on 
Window (Help About Window) online help systems from the Help menu item in 
the object view Menu Bar as shown in the following sample of the an object 
table view Menu Bar. 
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Web Client 

Navigation Online Help 

Provides information on how to navigate the Web Client and use Web Client 
features. If you click Help then Navigation from a window, wizard, or dialog, the 
online Help topic displayed provides help about the opened window, wizard, or 
dialog. This online help system also has an index and a search facility. 

 

Object - object_name - Help  

Provides object specific information. It includes a description of the object, 
actions available, and information about the object data fields in the object. 

Note: If the Object - object_name - Help for an object lists Actions, but the 
Actions menu option does not display any Actions, it is because your CA GMI 
license does not authorize you to use them. 

 

To access the Web Client Navigation online help system 

Click Help and then Navigation in the object Menu Bar, or in the opened 
window, wizard, or dialog. The help topic that pertains to that open window, 
wizard, or dialog is displayed. The help topic displayed when you click Help and 
then Navigation in the object Menu Bar is the Welcome page. 

You can also open this online help system by clicking Help in the top line of the 
main Web Client window. 

 

To access the Web Client Object - object_name - Help online help system 

Click Help and then Object - object_name - Help on the object Menu Bar. The 
Object - object_name - Help appears showing the help page related to the 
displayed object. 
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Chapter 2: Setting Up CA GMI 
 

This chapter explains how to set up CA GMI. 

This section contains the following topics: 

CA GMI Components (see page 61) 
Install and Configure CA GMI (see page 62) 
Start and Log In to the Windows Client (see page 64) 
Define a z/OS Host (see page 68) 
Connect and Log In to the z/OS Host (see page 70) 
Define the Data Collection Mode (see page 72) 
Closing the Windows Client (see page 74) 

 

CA GMI Components 

CA GMI consists of the following two components: 

z/OS Server 

Installed on the mainframe. 

User-Interface (PC) Clients  

The following user-interface clients are available: 

Windows Client  

This client is a Windows-based user-interface. This client provides full 
functionality and when you install the Windows Client you also install the 
Config Client and the CAVantage SRM documentation set. You can use the 
Config Client to set CAVantage SRM parameters. 

 

Web Client 

This client is a web-based user interface. The client can be used from any PC 
with internet access to the web client application server. You can access the 
CAVantage SRM documentation set from the web client. The current web client 
provides partial functionality compared to the Windows client.  

Note: Install the Windows client first and then the web client. The Windows 
client contains the Config client which you can use to set CAVantage SRM 
system parameters.  
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3270-based interface (View 3270 Client)  

This client provides partial functionality that is limited to: 

■ User-driven functionality of view and analysis 

■ Filtering and sorting, zooming 

■ Ability to initiate actions on selected entries  

Note: The View 3270 Client is considered a character-based user-interface, not 
a graphic-based user-interface, so it is not discussed in this guide. For View 
3270 Client installation and configuration information, see the chapter 
"Configuring CA GMI" in the CAVantage SRM Configuration Guide. For more 
information about using the View 3270 Client, see the chapter "Navigating the 
View 3270 Client" in the CAVantage SRM User Guide. 

 

Install and Configure CA GMI 

In order to use CA GMI you must install and configure both the z/OS component and at 
least one of the User-Interface (PC) Client components (you can use the Windows Client, 
the Web Client, or both). 

Note: If you have already installed CA GMI components for one of the other CA GMI 
enabled products, there is no need to install the components again, however you must 
perform step 4 in the following procedure for the CA GMI qualified product. If you are 
installing the components for the first time, ensure that you have received the proper 
installation materials for the z/OS and the User-Interface (PC) Client components. If you 
do not have all the installation materials you need, then contact CA Support at 
http://ca.com/support. 

 

To install and configure both components of CA GMI 

Note: System software and hardware requirements for both components of CA GMI can 
be found in the CAVantage SRM Installation Guide.  

1. Install the z/OS server as described in the CAVantage SRM Installation Guide. 

The z/OS server is installed on your z/OS system. 
 

2. Install the Windows Client as described in the CAVantage SRM Installation Guide. 

The Windows Client is installed on at least one PC. 

Note: When you install the Windows Client, you also install the CAVantage SRM 
Config Client which you can use to set CAVantage SRM system parameters. If you 
want to use the Web Client, we suggest you install it after you have completed step 
8. However, you can install the Web Client after you have completed step 3 and to 
be able to use it to work with CA GMI enabled product objects you must complete 
step 4 for each CA GMI enabled product. For more information about installing, 
navigating, and using the Web Client, see the CAVantage SRM Web Client Guide.  

 

http://www.ca.com/support%20/t%20_blank
http://www.ca.com/support%20/t%20_blank
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3. Configure the parts of the z/OS server that are common to all CA GMI enabled 
products as described in the chapter “Configuring CA GMI” in the CAVantage SRM 
Configuration Guide. 

Common CA GMI parts of the z/OS server are configured on your z/OS system. 
 

4. Configure the parts of the z/OS server that are specific to your CA GMI enabled 
product according to the chapter “z/OS Host Configuration" in this guide. 

Your CA GMI enabled product objects are defined for retrieving your CA GMI 
enabled product object data by the CA GMI user-interface. 

Note: If you want to use the Web Client you can install it now or after you complete 
step 8. For more information about installation, starting, navigation, and using the 
Web Client, see the CAVantage SRM Web Client Guide.  

 

5. Start the Windows Client according to the section Start and Log in to the Windows 
Client (see page 64). 

The Windows Client is up and running on your PC. 
 

6. Define z/OS host connections as described in the section Define a z/OS Host (see 
page 68). 

At least one z/OS host is defined in your Host List. 
 

7. Connect the Windows Client to a z/O host and login as described in the section 
Connect and Log In to the z/OS Host (see page 70). 

The Windows Client is connected and logged in to a z/OS host. You can start using it 
to view and work with object data. 

 

8. Define the Windows Client data collection mode as described in the section Define 
the Data Collection (see page 72). 

Object data is automatically displayed in the object view when you open an object. 

Note: The latest version of the CAVantage SRM documentation set is available at 
http://ca.com/support. However, you can install the Windows Client first (with no 
configuration) and then access the CAVantage SRM documentation set. To access the 
CAVantage SRM documentation set from the Windows Client click Start, Programs, CA, 
CA Storage Resource Manager, Documentation, and then Manuals - z/OS, or from the 
Windows Client main menu Help drop-down menu click Manuals - z/OS. The CAVantage 
SRM documentation set consists of the following documents: 

■ CAVantage SRM Best Practices Guide 

■ CAVantage SRM Configuration Guide 
 

■ CAVantage SRM Installation Guide 
 

■ CAVantage SRM Message Reference Guide 
 

■ CAVantage SRM Reference Guide 
 

■ CAVantage SRM Release Notes 
 

http://www.ca.com/support%20/t%20_blank
http://www.ca.com/support%20/t%20_blank
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■ CAVantage SRM User Guide 
 

■ CAVantage SRM Web Client Guide 

■ CAVantage SRM Windows Client Guide 
 

Start and Log In to the Windows Client 

If you want to use the Windows Client for your CA GMI session then you must start it. 

By default, when you start the Windows Client, you automatically log in as the ADMIN 
user (the default administrator), no Windows Client Login dialog appears, and the 
Windows Client Main Window appears. However, if this default was changed to require 
a specific user ID and password, the Windows Client Login dialog appears when you 
start the Windows Client and you must provide a valid user ID and password. 

Note: For more information about creating and maintaining Windows Client logins, see 
the section User Manager in the CAVantage SRM Windows Client Guide. 

 

To start and log in to the Windows Client 

1. Click Start, Programs, CA, CA Storage Resource Manager, and select Windows 
Client. 

The Windows Client Login dialog appears as shown in the following sample. 
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2. Type in your Windows Client User ID and Password and click OK. 

The Windows Client Main Window appears with the Home Form dialog displayed as 
shown in the following sample. 

 
 

To start the Windows Client, click Start, Programs, CA, CA Storage Resource Manager, 
and select Windows Client. If no Windows Client login is required, the Windows Client 
Main Window appears with the Home Form dialog displayed. 
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Windows Client Menu Bar and Toolbar Options 

The top of the main window of the Windows Client has the following Menu Bar and 
Toolbar options: 

 

Note: For more information about the Windows Client Menu Bar and Toolbar options, 
see the CAVantage SRM Windows Client Guide or click the Help icon on the Windows 
Client Menu Bar. 

 

The Windows Client View 

Many Windows Client users prefer to close the Home Form dialog and display the Host 
List dialog and the Object Tree dialog.  

To close the Windows Client Home Form dialog click the Close dialog icon located at the 
top right hand corner of the Home Form dialog shown in the following sample. 

 
 

To display the Host List dialog click the Host List icon ( ) located in the Windows 
Client Toolbar. The following is a sample of the Host List dialog. 
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To display the Object Tree dialog click the Object Tree icon ( ) located in the Windows 
Client Toolbar. The following is a sample of the Object Tree dialog. 

 
 

You can resize and move displayed dialogs in the Windows Client the same as you resize 
and move opened windows on your PC desktop. Arrange the Host List and Object Tree 
dialogs so they display as shown in the following screen capture sample. 
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Define a z/OS Host 

After starting the Windows Client you need to connect the Windows Client to the z/OS 
server component. In order to connect the Windows Client to the z/OS server 
component, you must first define the z/OS server or servers that you plan to use. The 
Windows Client Host List feature is used to define z/OS server connections. 

You can define as many z/OS servers as you want and you can simultaneously connect 
to as many z/OS servers as you want (as long you have installed and configured the z/OS 
server component on them). 

 

To define a z/OS host 

Note: The following procedure assumes you have started the Windows Client and the 
Host List dialog is not displayed. If the Host List dialog is already displayed then you can 
skip step 1. 

1. Click the Host List icon ( ) in the Windows Client Toolbar. 

The Host List dialog appears as shown in the following sample. 

 
 

2. Click the New Host icon ( ) in the Host List dialog. 

The Host Definition dialog appears as shown in the following sample. 
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3. Complete the Host Definition dialog, the field options are: 

Host 

Provides the Host Name displayed in the Host List dialog. 

Agent Name 

Provides the name of the agent that collects data from the host. Select z/OS if 
it is not already displayed. 

 

IP Address 

Defines the IP address or server name of the z/OS host to which you are 
connecting. 

 

Port Number 

Defines the port number of the z/OS host to which you are connecting. 
 

User ID 

(Optional) Provides the user ID, which is sent to the host in encrypted form. If 
you do not specify a user ID then you must enter it every time you try to 
connect the Windows Client to the z/OS host. 

 

Password 

(Optional) Provides the password, which is sent to the host in encrypted form. 
If you do not specify a password then you must enter it every time you try to 
connect the Windows Client to the z/OS host. 

Note: You also have the option of providing the z/OS host user ID and not the 
password when setting up your Host Definition; this is often done at sites 
where security policies require Passwords to be changed periodically. 

 

Confirmation 

Confirms the password, if you provide a password then you must provide the 
same password in the confirmation field. 

 

Host Trace 

(Optional) Creates a trace on the host of all the messages exchanged between 
the z/OS host and the Windows Client. For more information about this field 
click the Help icon. 

 

PC Communication Trace 

(Optional) Indicates if the system should save the messages relating to 
host-client communication in a log file. For more information about this field 
click the Help icon. 

 

4. Click Test to test your connection information. 

The Windows Client advises you if your connection to the z/OS host is successful. 
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5. Click Save. 

The Windows Client stores the host definition. The new host definition appears in 
the Host List dialog. The Host List dialog displays all your defined hosts and their 
connection status. 

The following is a sample of the Host List dialog showing the different connection 
status icons. 

 
 

Host List Dialog Toolbar Options 

The Windows Client Host List dialog provides the following toolbar options: 

 

 
 

Connect and Log In to the z/OS Host 

After you start the Windows Client and have defined z/OS host connections, you can 
then connect the Windows Client to a z/OS host and log in to the z/OS host. Once that is 
done you can start using CA GMI. 
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To connect and log in to the z/OS host 

Note: The following procedure assumes you have predefined your z/OS hosts and they 
are displayed in the Host List dialog. If you do not have predefined hosts in the Host List 
dialog then see the section Define a z/OS Host. If the Host List dialog is already displayed 
in your Windows Client window then skip step 1. 

1. Click the Host List icon ( ) in the toolbar. 

The Host List dialog appears. The following is a sample of the Host List dialog. 

 
 

2. Select the host to which you want to log in to from the Host List dialog. 

The selected host definition is highlighted as shown in the following sample. 

 
 

3. Click the Connect icon ( ) in the Host List dialog toolbar. 

If your user ID and password were provided in the Host Definition dialog for the 
selected host, the Windows Client attempts to connect to the host. If the 
connection is successful then the connection status icon changes from the Not 

Connected icon ( ) to the Connected icon ( ). You can begin using CA GMI and 
you can skip step 4. 

If your user ID and password were not provided in the Host Definition dialog for the 
selected host, then the Host Login dialog appears as shown in the following sample 
dialog, and you must proceed to the next step. 
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4. Enter a valid user ID and password in the Host Login dialog, and click OK. 

The Host Login dialog disappears. 

The Windows Client attempts to connect and log on to the z/OS host. When the 
connection and log on is complete, the connection icon in the Host List Dialog 

changes from the Connecting icon ( ) to the Connected icon ( ), as shown in 
the following sample, and you can begin using CA GMI. 

 

Note: For more information about defining hosts and connecting to hosts, see the 
CAVantage SRM Windows Client Guide or the online help. 

 

Define the Data Collection Mode 

CA GMI can be configured to collect data in either Automatic or Manual mode. 

■ In Automatic mode, object data is collected automatically when you open an object.  

■ In Manual mode, object data is only collected by the Windows Client when you click 

the Execute icon ( ) in the open object view Toolbar. 
 

To define the data collection mode in the Windows Client 

1. Click Tools in the Windows Client main window Menu Bar. 

The following is a sample of the Windows Client main window Menu Bar and 
Toolbar. 

 
 



Define the Data Collection Mode 

 

Chapter 2: Setting Up CA GMI  73  
 

The Tools menu expands to display available items, as shown in the following 
sample: 

 
 

2. Select Options from the Tools menu drop-down list. 

The Global Options dialog appears, as shown in the following sample: 

 
 

3. Select the General tab. 

The General tab is displayed in the Global Options dialog. 
 

4. Select View z/OS Execution. 

A down arrow is displayed in the View z/OS Execution field. 
 

5. Select the down arrow in the View z/OS Execution field. 

A drop down list with choices of Automatic or Manual is displayed. 
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6. Select the mode you want the system to use and click OK. 

The Global Options dialog closes. When you select an object in the Object Tree the 
Windows Client will collect data based on the mode that you have selected. 

Note: The examples in this guide assume that Automatic mode is selected. 
 

Closing the Windows Client 

When you close the Windows Client it will log you off from your connected hosts. 
However, when you are finished working you should disconnect from hosts first then 
close the Windows Client. 

To close the Windows Client 

1. Select the host you are connected to in the Host List dialog. 

The selected host is highlighted. 

2. Click the disconnect icon ( ) in the Host List dialog. 

The status icon of the selected host will change from connected ( ) to 
disconnected ( ). 

 

3. Repeat steps 1 and 2 and close all host connections. 

All hosts displayed in the Host List dialog are displayed with the disconnected icon 

( ). 
 

4. Close the Windows Client by clicking the Close icon ( ) in the top right hand 
corner of the Windows Client. 

The Windows Client is no longer displayed. 
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Chapter 3: z/OS Host Configuration 
 

This section contains the following topics: 

Before You Start (see page 75) 
Configure CA GMI for CA 1 (see page 75) 

 

Before You Start 

The instructions in this chapter assume you have performed the first two steps 
described in the section Install and Configure CA GMI (see page 62). Do not perform the 
instructions in this chapter before you have completed those steps.  

After you have completed the instructions in this chapter, return to the chapter "Setting 
up CA GMI", and perform the rest of the steps listed in the section Install and Configure 
CA GMI (see page 62).  

 

Configure CA GMI for CA 1 

A storage administrator usually performs most of the steps in the following procedure. 
To find the exceptions, tasks typically done by a system programmer, look for items 
starting with (SYSPROG).  

Some steps in the following procedure involve setting security access authority, see your 
security administrator to confirm or establish the proper access authorities for those 
steps. For more information about security, see the section Actions Against Tape 
Related Objects in the topic "Security Topics" in the CAVantage SRM Reference Guide. 

 

To configure CA GMI for CA 1 

1. Run INSTALL Job J05CA1. 

This job copies system script and parmlib members for CA 1 to the script and 
parmlib data sets. This job is located in the CCTUSAMP library, customize it to your 
needs as instructed in the comments at the beginning of the member, and run it 
now. 

 

2. Configure Disk Interval Scripts for CA 1. 

This product's Disk Checkpoint service enhances system performance for vendor 
objects in which the vendor APIs are considered too slow for retrieving a large 
number of records. Tape management (volume and file) objects are in this group. 
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Disk Checkpoint data sets are dynamically allocated and written with the aid of 
scripts. Sample scripts are distributed in the CCTUSAMP library. Each script uses the 
tape management system's native API (which can be rather slow) to retrieve the 
needed data, at a scheduled low-impact time, and checkpoint it to a sequential disk 
file.  

 

When you request these objects from any of this product's clients, View Mode=DC 
is automatically used (it is the default), and the data is read from the checkpoint 
data set at a much higher speed. View Mode=RT may also be a choice, which means 
that the slower native API will be used to get the data in Real-Time, and you will 
have to wait considerably longer to get the data.  

 

Proper configuration involves scheduling the checkpoint scripts to run just 
frequently enough to allow normal analysis to be done from the checkpoint data. 

  

The reformatted data buffers are written to a pair of high-performance Disk Interval 
files. CTSXUTIL also performs the following tasks:  

■ Create disk interval file containing VMF volume records  

■ Create disk interval file containing VMF file (data set) records  
 

■ A SYSPRINT audit report that details the number and type of records processed  
 

■ Create a z/OS name and token pair to pass the disk interval data set names to 
CA Vantage SRM  

Note: The z/OS name and token pairs created (CTSXUTIL$VANTAGE) is online and 
accessible until the next system IPL.  

 

The J05CA1 job copies the following scripts from the CCTUSAMP library to your 
system-script library, as named by system parameter SYSTSCR. We recommend that 
you enable these scripts. The header of each sample contains information on how 
to activate the script. 

DSKTMCF  

Object: Files  

Type: DC  

DSKTMCV  

Object: Volumes  

Type: DC   
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3. Configure the first part of the Summary Reports for CA 1. 

This product provides several tape summary reports for CA 1. To enable these 
reports do the following: 

Edit PARMLIB member SUMMARY to activate the reports. If this member does not 
exist, copy it from the CCTUSAMP library. The following is an example of part of the 
SUMMARY member: 

********************************************************************** 

* 

* TAPE MANAGEMENT SYSTEMS SUPPORTED: 

* 

********************************************************************** 

*%%INCLUDE MEMBER=SUMRVIS   * SUMMARY DEFS FOR CA 1 - TMC SUMMARIES 

*%%INCLUDE MEMBER=SUMRTLMS  * SUMMARY DEFS FOR CA TLMS SUMMARIES 

*%%INCLUDE MEMBER=SUMRRMM   * SUMMARY DEFS FOR DFSMSRMM SUMMARIES 

*%%INCLUDE MEMBER=SUMRZAR   * SUMMARY DEFS FOR ASG-ZARA SUMMARIES 
 

To activate the summaries for CA 1, delete the asterisk in column 1 in the following 
line: 

*%%INCLUDE MEMBER=SUMRVIS   * SUMMARY DEFS FOR CA 1 - TMC SUMMARIES 

Note: Additional configuration is required to complete the configuration of 
Summary Reports for CA 1 as described in subsequent steps. 

 

4. Configure Tape Summary Report Filters for CA 1. 

Note: The following FILTVIxx members must be created and customized for tape 
volume summaries to work properly. If they do not exist in your PARMLIB yet, copy 
them from the CCTUSAMP library. 

The following is a list of PARMLIB members for the CA 1 Tape Volume Summaries: 

FILTVIJO 

Used to qualify tapes into groups depending on the last job name that used the 
tape. 

FILTVIMB 

Used to qualify tapes into groups depending on MBs written to the tape. 
 

FILTVIMC 

Used to qualify tapes into groups depending on the SMS management class 
(MC) of the tape. 

 

FILTVIOU 

Used to qualify tapes into groups depending on the OUTCODE defined for the 
tape. 
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FILTVIRO 

Used to qualify tapes into groups depending on the Robot ID saved in the CA 1 
TMC records. To make use of this summary group function, you must update 
the ROBID field in the TMC (you can use the TMSUPDTE utility). 

 

FILTVITD 

Used to qualify data set name patterns into groups that correspond to your 
installation. 

 

5. Perform the following steps to configure the FILTVIxx Members: 

a. Observe that the sample FILTVITD member looks like the following: 

* 

SET_SUM_LABEL=GRP PSS.A300./ 

SET_SUM_FILTER=SCRATCH = N AND 'DATA SET NAME' INCL 'PSS.A300./' 

* 

SET_SUM_LABEL=GRP2 DMSOS./.104 

SET_SUM_FILTER=SCRATCH = N AND 'DATA SET NAME' INCL 'DMS0S./' 

* 

SET_SUM_LABEL=G3 SYS4S.MVSS./ 

SET_SUM_FILTER=SCRATCH = N AND 'DATA SET NAME' INCL 'SYS4S.MVSS./ 

* 
 

b. Customize this member to suit your installation. 

Create groups consisting of the following two keywords: 

SET_SUM_LABEL= 

SET_SUM_FILTER= 

A maximum of 1000 such groups is allowed. 

SET_SUM_LABEL= 

Gives the grouping its group name. In the example above, the group name 
for the first group is GRP PSS.A300./. A maximum of 16 characters can be 
used to describe the group name. 

 

SET_SUM_FILTER= 

Qualifies the tapes into the different groups you create. Use the SCRATCH 
= N keyword to select only active tapes in the group (not tapes with 
scratch status). For a list of other field variables that can be used in the 
filter, run the GENMAP utility for object VISTMCS. See member MAPPINGS 
in the CCTUSAMP library for this utility. All the substitution variables 
(without the enclosing %% signs) can be used within the filter. 
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The SET_SUM_FILTER= statement has the following general syntax: 

       SET_SUM_FILTER=('field name' comparator value) AND|OR 

         ('field name' comparator value) 

Observe the following SET_SUM_FILTER syntax rules: 

-  This statement must begin in column one. Comment statements are 
indicated by an asterisk in column one. 

 

-  You can use as many field name comparator value criteria as necessary, 
connected through any combination of logical AND and OR operators. 
Parentheses are needed only to clarify the desired logic when multiple 
AND and OR operations are specified. 

 

-  Do not go beyond position 72 in a definition line. If the definition extends 
to a second line, split the text between words (not in the middle of a 
word). Leaving a blank in position one of the new line is recommended. 

 

-  When a field name contains a blank, it must be contained within single 
quotes. If the field name does not contain a blank, the quotes are not 
needed. 

 

-  For numeric fields, the comparator can be any of the common LE, LT, EQ, 
NE, GE, or GT comparison operators. 

 

-  For character fields, use the INCL or EXCL operators to indicate that the 
following list of test values are to be either included or excluded 
respectively. Parentheses can be used around a list of test values, and are 
recommended for clarity when more than one value is given. However the 
parentheses are not required. Items in a list can be separated by commas 
or blanks. For example: 

      'DATA SET NAME' INCL (PSS.A300./,SYS4/,DB2/) 
 

-  Test values for character fields can be either exact character strings, or 
pattern strings. For patterns, use the question mark (?) to represent any 
variable character, and the forward slash (/) to match any characters that 
follow. For example, TSO?5/ accepts any character after TSO and any suffix 
after the digit 5. 

Note: For more information on wildcard characters, using quotes, and 
filtering, see the section Global Concepts, Functions, and Features in the 
CAVantage SRM User Guide. 

 

c. Customize the other FILTVIxx members to suit your installation. 

Note: For information regarding syntax rules, see the topic "Filter Syntax Rules" 
in the CAVantage SRM Reference Guide for more information.  

 

6. (SYSPROG) Identify the CA 1 Common Options Library. 

Specify CAVantage SRM system parameter CAPPOPT (dsname) with the name of 
your CA 1 common options library (the CAI.CTAPOPTN data set). CAVantage SRM 
needs to find this data set in order to retrieve various CA 1 option members.  
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7. Configure TMCDSNB Script for Performance - DSNB Information.  

When displaying tape volume information, summary information about all the data 
sets on each volume is included. If this information is fetched using the native API 
to the Tape Management Catalog (TMC) at the time of the request (in real-time (RT) 
mode), it can take considerable time, depending on the number of data sets 
stacked on individual tapes (the number of DSNBs per volume).  

 

To speed up this process, you should use script TMCDSNB, which collects the 
summary information in advance, on a schedule you specify, and keeps it in 
memory. This memory copy is then used as the source of the DSNB summary 
information whenever a real-time (RT) view of the tape volume object is requested 
- dramatically improving performance.  

 

Note: Disk Checkpoint (DC) objects are provided for similar performance reasons 
and are the default mode whenever appropriate. However, real-time (RT) views of 
tape volumes are also needed at times, which is why this performance script should 
be used.  

The TMC DSNB performance script is TMCDSNB for CA 1 object Volumes (RT).  
 

To enable this performance related script  

a. Schedule when this script should run. To schedule when this script should run, 
do the following:  

Note: Run once every 24 hours after your daily TMC clean process has been 
completed.  

Use TSO/ISPF to edit the TMCDSNB member and set PERFORM_EVT_PROC to 
the desired day and time you want it to run. To do this, uncomment the 
statement that looks like the following, and specify the correct day and time. 
(Delete the asterisk in column 1, and ensure PERFORM … starts in the first 
column.) Valid values for the ON_DAY= parameter are: ALL, MON, TUE, WED, 
THU, FRI, SAT, or SUN.  

*PERFORM_EVT_PROC=ON_DAY=ALL,AT_TIME=0700  
 

b. Activate and Execute the script. To activate and execute the script, perform the 
following steps:  

1. Specify system parameter TMCPERFS (Y).  

2. Enter the following commands:  

F SAMS,AUTO,REFRESH=SYSTEM,TMCDSNB  

F SAMS,AUTO,FIRE=SYSTEM,TMCDSNB  
 

Wait until the script completes execution before requesting the TMC volume 
object. The following console message is given when it ends:  

VAN0735I Automation Script SYSTEM TMCDSNB: Control returned from the 
Event Procedure  
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After the above message is given, the DSNB data will be available in memory 
immediately, and the tape volumes object can be created and displayed much 
more quickly.  

 

8. (SYSPROG) Identify the CA 1 TMOSYSxx Member Name as follows: 

Specify CAVantage SRM system parameter CATMOSYS (TMOSYSxx) with the correct 
name of the CA 1 member containing its active system options. CAVantage SRM 
uses this to find and display the other CA 1 option members in the common options 
library.  

 

9. (SYSPROG) Grant Security Authority to Perform TMC Actions as follows: 

To allow users the ability to perform actions on objects residing in the Tape 
Management Catalog (TMC), you must give them authority within your security 
system to update the TMC data set.  

Note: For more information, see the topic “Security Topics” in the CAVantage SRM 
Reference Guide.  

 

10. Stop and Restart CAVantage SRM.  

CA GMI is up and running. 
 

11. Return to the section Install and Configure CA GMI (see page 62) and continue the 
rest of the setup. The instructions tell you how to start the Windows Client and 
create host definitions so that you can work with CA 1 objects described in the 
chapter "CA 1 Objects." 
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Chapter 4: Using CA 1 Objects 
 

This chapter explains how to use the CA 1 objects that are available in the GMI Windows 
Client Object Tree. 

 

Use the GMI Windows Client GUI to Access CA 1 Objects 

All CA 1 objects are included in the Tape Resource Management folder of the Object 
Tree. 

Note: Before you begin, make sure that the z/OS host that you want to connect to is 
up-and-running.  

To access CA 1 objects 

1. Click Start, Programs, CA, CA Storage Resource Manager, and select Windows 
Client. 

The GMI Windows Client appears. The following is a sample of the GMI Windows 
Client main window Menu Bar and Toolbar. 

 
 

2. Click the Host List icon in the GMI Windows Client main windows Toolbar. 

The Host List dialog opens. The following is a sample of the Host List dialog. 
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3. Select the z/OS host that you want to connect to and click the Connect icon . 

If your user ID and password were provided in the Host Definition dialog for the 
selected host, the GMI Windows Client attempts to connect to the host. If the 
connection is successful then the connection status icon changes from the Not 

Connected icon   to the Connected icon . You can skip step 4. 

If your user ID and password were not provided in the Host Definition dialog for the 
selected host, then the Host Login dialog appears as shown in the following sample. 
You must proceed to step 4. 

 

Enter a valid user ID and password in the Host Login dialog, and click OK. 

The Host Login dialog disappears. 

The GMI Windows Client will attempt to connect and log on to the z/OS host. If the 
connection is successful then the connection status icon in the Host List dialog 
changes from the Not Connected icon  to the Connected icon . GMI will 
collect information from the z/OS host that you have chosen to connect to. 
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4. Click the Object Tree icon  in the GMI Windows Client main windows Toolbar. 

The Object Tree dialog appears. The following is a sample of an Object Tree. 

 
 

5. Click the plus sign next to the Tape Resource Management folder. 

The Tape Resource Management folder is expanded, as shown in the following 
sample. 
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6. Click the plus sign next to the Tape Management Systems folder. 

The Tape Management Systems folder is expanded, as shown in the following 
sample. 

 
 

7. Click the plus sign next to the CA 1 folder. 

The CA 1 objects are displayed in the Object Tree, as shown in the following sample.  
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Use the Online Help Systems for More Information 

You can access two types of online help systems from the GMI Windows Client: 

Help on Window 

Provides information on how to use GMI Windows Client features. 

Help on Object 

Provides object specific information, including information about the object data 
fields in each object. 

 

To access the Help on Window online help system 

1. Right-click on an object in the Object Tree dialog. 

The Object pop-up menu appears as shown in the following sample. 

 

2. Click Help on Window. 

The GMI Windows Client online help system appears showing the help page related 
to the window from which the Help on Window was selected. 
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To access the Help on Object online help system 

1. Right-click on an object in the Object Tree dialog. 

The Object pop-up menu appears. 

2. Click Help on Object. 

The Help on Object system appears showing the help page related to the object 
selected as shown in the following sample of the Help on Object for the CA 1 
Volumes object. 

 
 

Example: Display help from an object view 

You can also access the Help on Object (Help About Object) and the Help on Window 
(Help About Window) online help systems from the Help menu item in the object view 
Menu Bar as shown in the following sample of the CA 1 Volumes object view Menu Bar. 

 

GMI Object Action Options 

The Actions option is available only for certain objects and it is used to perform actions 
on specific object items. The actions available for an object relate to specific 
functionality of the object being accessed. For CA 1 objects the Actions feature is 
available for Volumes and Files objects. 
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Example: Display Volumes object Action menu 

The following is a sample of the Volumes object Action menu. 

 

Note: When object actions are performed, security checks are made with the proper 
access levels. The user ID for each security check will be either the user ID associated 
with the GMI started task, or the user ID that owns the script (the person who created 
or last modified it). For more information about the security system see the description 
of system parameter SECURSCR in the CA Vantage Storage Resource Manager Reference 
Guide. 

 

Display Actions Dialog Feature 

You can use the actions dialog feature to perform actions on some objects. 

To start the Actions dialog feature 

1. Click an object in the Object Tree dialog. 

An object in Table View appears in your GMI Windows Client. 

2. Select a line of object data in the object Table View that you want to perform the 
action on. 

The line of object data in the Table View is highlighted. 
 

3. Click Actions in the Table View Menu Bar. 

The Actions drop down list appears. 
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4. Click the Action you want to perform. 

The Actions dialog appears. 

Note: For more information about how to use the Actions dialog view the Help on 
Window online help system. For more information about an object and available object 
actions view the Help on Object online help system. 

 

GMI Objects for Analyzing CA 1 Activity 

The following sections explain how to use CA 1 objects to analyze your tape information. 

The following objects are available: 

 

Object Task 

Volumes Display detailed information on volumes stored in the CA 1 
Tape Management Catalog (TMC). 

Files Display the files that reside on tape volumes. 

System Definitions Display the names of CA 1 Initialization members in the 
CTAPOPTN Data Set, and the status of each member 
(Active/Inactive). 

Broken Chains Display the broken chains in the CA 1 TMC. 

Audit Details Display detailed information from CA 1 TMC Audit Records. 

Audit Change Report Display a report of the TMC records that have changed, along 
with a list of the fields that were modified. 

By Expire Date Display summary of tapes grouped by expiration date type. 

By Used MB Range Display summary of tapes grouped by used MB range. 

By DSN Group Display summary of tapes grouped by data set name. 

By Last Used Job Display summary of tapes grouped by last used job. 

By Tape RobotID Display summary of tapes grouped by tape robotID. 

By Tape SMSMC Display summary of tapes grouped by tape SMS Management 
Class. 

By Tape OUTCode Display summary of tapes grouped by tape OUTCode.  

These objects are described in the following sections in the order that they appear in 
the Object Tree. 
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Volumes Object 

The Volumes object lists all items of information about tape volumes stored in the CA 1 
Tape Management Catalog (TMC). 

The Volumes object is useful in monitoring the tape activity in your CA 1 environment. It 
provides visibility to the tape data sets on the system and the volumes that they reside 
on. 

 

Display Volumes Object 

You can display the Volumes object to view information about tape volumes stored in 
the CA 1 TMC. 

Note: The CA 1 TMC must be active or batch active on your system for this function to 
be available. 

To display CA 1 volume information 

1. Open the Object Tree so it is showing the CA 1 objects as described in the section 
Use the GMI Windows Client GUI to Access the CA 1 Objects (see page 83).  

CA 1 objects are displayed in the Object Tree. 

2. Click the Volumes object in the Object Tree. 

The Table View of the Volumes object appears as shown in the following sample. 
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Volume Object Actions Menu 

The following actions are available from the Actions option located on the Volumes 
object view Menu Bar. 

Scratch 

Sets the status of the selected volume to Scratch, making the volume reusable. 

Note: Tapes that are under Catalog control must be uncataloged before they can be 
scratched or the expiration date (expdt) must be changed to today's date. 

UnScratch 

Removes the Scratch status from the selected volume. 

Note: Data Set Name Blocks (DSNBs) that were related to this volume are not 
restored. They can be manually updated using batch job TMSAGGR. 

 

Checkout 

Checks out the selected tape to a vault. 
 

Checkin 

Checks in a checked out tape volume. 
 

Expire 

Expires the selected volume. The Expiration date is changed to the current date. 

Note: If the tape is a part of a multi volume chain, all tapes on the chain are 
expired. You must select the first tape on the chain. The new expiration date is set 
to the current date plus an optional delay value specified by the CA 1 option RR 
(from the TMOOPTxx member of the CA 1 options library). By default, the RR value 
is zero. 

 

Extend 

Extends the expiration date of the selected volume by the number of days specified 
in the Days field. 

 

View TMCDSNB Scr 

Opens the PDS Member Editor dialog showing the source text of the TMCDSNB 
script. 

 

Run TMCDSNB Scr 

Executes the TMCDSNB script. 
 

Configure TMCDSNB 

Opens the Systems Script Builder feature for editing the selected script. 
 

View DSKTMCV Scr 

Opens the PDS Member Editor dialog showing the DC mode script for this object. 
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Run DSKTMCV Scr 

Runs the DC mode script associated with this object. 
 

Configure DSKTMCV 

Opens the Systems Script Builder feature for editing the selected script. 
 

Example: Display the Volume Object Extend action dialog 

The following is a sample of the Action dialog that appears when you select the Extend 
action. The sample shows that the selected data set on volume 100001 is extended 365 
days. 
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View Detailed Volume Object Information 

You can use the Details dialog to view detailed information associated with a Volume 
object line item. 

To view detail item Volume information 

1. Select an object item line in the Table View of the Volume object. 

The object item line is highlighted. 

2. Click the Display Detailed Line icon  on the object view Menu Bar. 

The Details dialog appears. The following is a sample of the CA 1 
Volumes/VISTMCS - Details dialog for Volume 100001. 

 

Note: For field definitions click the help icon  on the Details dialog Menu Bar. 
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Zoom to Another Object from the Volume Object 

You can work with multiple objects at the same time using zooms. A zoom is a view of 
another z/OS object related to the currently displayed object. 

To zoom to object information in another object 

1. Click a row in the Table View of the CA 1 Volumes/VISTMCS object. 

The row is highlighted. 
 

2. Click the Open Zoom icon  in the Table View Menu Bar. 

The Zoom list of CA 1 Volumes/VISTMCS dialog appears. The list consists of objects 
related to the CA 1 Volumes/VISTMCS object. The following is a sample of the Zoom 
list of CA 1 Volumes/VISTMCS dialog. 

 

The Zoom list allows you to select a CA 1 object and open a window that displays 
only the data associated with the selected volume. 

 

3. Click an object in the Zoom list of CA 1 Volumes/VISTMCS dialog. 

The Table View of the object selected appears showing only information found in 
the object selected that is related to the Volume highlighted in step 1. 
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Example: Display CA 1 Data Set Name Blocks (DSNBS) object information related to 
CA 1 Volume 102338 

In the following example the Zoom to CA 1 Data Set Name Blocks (DSNBs)/VISDSNB 
displays the data set associated with the selected volume 102338. 

 

 
 

Files Object 

The CA 1 Files object shows the files that reside on tape volumes. Data is collected by 
reading the TMC volume and DSNB records to obtain the information for the first file, 
then the DSNBs are read to obtain information on every file on the volume. Volumes 
with the Delete flag set to Yes are excluded. 

 

Display Files Object 

You can display the Files object to view files that reside on tape volumes. 

To display CA 1 files on tape volumes 

1. Open the Object Tree so it is showing the CA 1 objects as described in the section 
Use the GMI Windows Client GUI to Access CA 1 Objects (see page 83). 

CA 1 objects are displayed in the Object Tree. 
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2. Click the Files object in the Object Tree. 

The Table View of the Files object appears. The following is a sample of the Files 
object Table View. 

 
 

Files Object Actions Menu 

The following actions are available from the Actions option found on the Files object 
view Menu Bar. 

View DSKTMCF Scr 

Opens PDS Member Editor dialog that shows the DC-mode script for this object. 

Run DSKTMCF Scr 

Runs the DC-mode script associated with this object. 

Configure DSKTMCF 

Opens the Systems Script Builder feature for editing the selected script. 
 

System Definitions Object 

The CA 1 System Definitions object shows the names of CA 1 Initialization members in 
the CTAPOPTN Data Set, and the status of each member (Active/Inactive). 
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Display System Definitions Object 

You can display the Volumes object to view the names and status of CA 1 Initialization 
members in the CTAPOPTN Data Set. 

To display CA 1 system definitions 

1. Open the Object Tree so it is showing the CA 1 objects as described in the section 
Use the GMI Windows Client GUI to Access CA 1 Objects (see page 83). 

CA 1 objects are displayed in the Object Tree. 
 

2. Click the System Definitions object in the Object Tree. 

The Table View of the System Definitions object appears. The following is a sample 
of the System Definitions object Table View. 

 
 

Broken Chains Object 

The CA 1 Broken Chains object shows the broken chains and errors in the CA 1 TMC. The 
following types of errors can be listed in the display: 

■ Errors encountered while scanning the DSNB chain 

■ Errors encountered while scanning the DSNB freechain 

■ Errors encountered while scanning the multivolume chain 

Note: For information on how to repair broken chains and errors in the TMC see the 
Utilities and Report Reference Guide. 
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Display Broken Chains Object 

You can display the Broken Chains object to view chains and errors in the CA 1 TMC. 

To display CA 1 broken chains 

1. Open the Object Tree so it is showing the CA 1 objects as described in the section 
Use the GMI Windows Client GUI to Access CA 1 Objects (see page 83). 

CA 1 objects are displayed in the Object Tree. 
 

2. Click the Broken Chains object in the Object Tree. 

The Table View of the Broken Chains object appears. The following is a sample of 
the Broken Chains object Table View. 

 

 
 

Audit Details Object 

The Audit Details object shows detailed information from the CA 1 TMC Audit Records. 
The Audit data set serves as a transaction log. An Audit record is written to reflect every 
update to the TMC data set and other tape processing and CA 1 initialization events. In 
the event the TMC is destroyed, the Audit data written since the last backup of the TMC 
is used in restore processing. There are six types of Audit records: 

■ Batch or online TMC update activity 

■ Tape input processing activity 

■ Tape output processing activity 
 

■ Exceptions (nonresident tape processing, password violations, record updates 
bypassed by user exits, and so forth) 

 

■ Tapes rejected for use by CA 1 (not scratch violations) 

■ TMC structural modification and CA 1 initialization information 
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Display Audit Details Object 

You can display the Audit Details object to view details of audit records. 

To display audit details records 

1. Open the Object Tree so it is showing the CA 1 objects as described in the section 
Use the GMI Windows Client GUI to Access CA 1 Objects (see page 83). 

CA 1 objects are displayed in the Object Tree. 
 

2. Click the Audit Details object in the Object Tree. 

The Table View of the Audit Details object appears. The following is a sample of the 
Audit Details object Table View. 

 
 

Audit Change Report Object 

The CA 1 Audit Change Report object shows detailed information for the TMC records 
that have changed along with a list of the fields that were modified. Reports on one, all, 
or a combination of Audit record types can be produced. You can set the Sort sequence 
by data set name, volume serial number, or Audit date/time. Audit reports can also be 
requested for specific volume serial numbers or a range of volume serial numbers to 
assist in researching tape activity. 

You can zoom from this object to the Audit Details object to get a look at the detailed 
before and after images of the affected TMC record. 

Note: This report is only available if the CTAPOPTN field AUDB4 is set to BATCH or ALL.  
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Display Audit Change Report Object 

You can display the Audit Change Report object to view details of changed audit 
records. 

To display the CA 1 Audit Change Report 

1. Open the Object Tree so it is showing the CA 1 objects as described in the section 
Use the GMI Windows Client GUI to Access CA 1 Objects (see page 83). 

CA 1 objects are displayed in the Object Tree. 
 

2. Click the Audit Change Report object in the Object Tree. 

The Table View of the Audit Change Report object appears. The following is a 
sample of the Audit Change Report object Table View. 

 

Note: To display the changed fields for this object, you must set the CTAPOPTN field 
AUDB4 to BATCH or ALL. This causes the before update image of the TMC record to be 
saved in the Audit file. 

 

Summary of Tapes By Expire Date Object 

The CA 1 summary of tapes By Expire Date object shows a summary of tapes grouped 
by expiration date type. The CA 1 TMC controls all of the tapes in the summary. The CA 
1 Tape Volume unfiltered records provide input to this summary. 

 

For each type of external expiration date found in the TMC, one summary record is 
generated that contains: 

■ The external expiration date 

■ The number of tapes in that group 
 

■ What percent of the total that group represents 
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■ Total allocated MB 

■ Average, minimum, and maximum allocated space for the tapes in that group 
 

Display By Expire Date Object 

You can display the By Expire Date object to view a summary of tapes grouped by 
expiration date type. 

To display a CA 1 summary of tapes by expiration date type 

1. Open the Object Tree so it is showing the CA 1 objects as described in the section 
Use the GMI Windows Client GUI to Access CA 1 Objects (see page 83). 

CA 1 objects are displayed in the Object Tree. 
 

2. Click the By Expire Date object in the Object Tree. 

The Table View of the Summary of Tapes By Expiration Date object appears. The 
following is a sample of the Table View of the By Expire Date summary information. 

 
 

Summary of Tapes By Used MB Range Object 

The CA 1 summary of tapes By Used MB Range object shows a summary of active tape 
MB ranges. Tapes are grouped based upon the number of bytes written to the tape. The 
CA 1 TMC catalog controls all of the tapes in the summary. The CA 1 Tape Volume 
unfiltered records provide input to this summary. 

 

This summary is organized by filters defined in the CA Vantage parmlib data set member 
FILTVIMB. Update member FILTVIMB to use the MB range groupings in effect at your 
site. 
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For each group or MB range (as defined in FILTVIMB), this object creates one summary 
record containing: 

■ Group name 

■ Number of tapes in the group 
 

■ Percent of the total the group represents 
 

■ Total allocated MB 

■ Average, minimum, and maximum allocated space for the tape in that group 
 

Display By Used MB Range Object 

You can display the By Used MB Range object to view a summary of tapes grouped 
based upon the number of bytes written to the tape. 

To display CA 1 summary of tapes by used MB range 

1. Open the Object Tree so it is showing the CA 1 objects as described in the section 
Use the GMI Windows Client GUI to Access CA 1 Objects (see page 83). 

CA 1 objects are displayed in the Object Tree. 
 

2. Click the By Used MB Range object in the Object Tree. 

The Table View of the Summary of Tapes By Used MB Range object appears. The 
following is a sample of the Table View of the By Used MB Range summary 
information. 
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Summary of Tapes By DSN Group Object 

The CA 1 summary of tapes By DSN Group object shows a summary of active tapes 
grouped by data set name. Tapes are grouped based upon the first data set name 
written on the tape. The CA 1 Tape Volume record accounts for all DSNBs on a tape. The 
CA 1 TMC controls all of the tapes in the summary. The CA 1 Tape Volume unfiltered 
records provide input to this summary. 

Note: Secondary DSNBs do not influence the assignment of a tape to its data set group, 
but the space they occupy is included in the totals. 

 

This summary is organized by filters defined in the CA Vantage parmlib data set member 
FILTVITD. Update member FILTVITD to use the DSN groupings in effect at your site. 

 

For each group of tapes (as defined in <parmlibMember>), this object creates one 
summary record containing: 

■ Group name 

■ Number of tapes in the group 
 

■ Percent of the total the group represents 
 

■ Total allocated MB 

■ Average, minimum, and maximum allocated space for the tape in that group 
 

In addition, this table shows the average, minimum, and maximum values for the total 
number of: 

■ DSNBs on the selected tapes 

■ Opens for all the tapes in the group 

■ Tape blocks on all the tapes in the group 
 

Display By DSN Group Object 

You can display the By DSN Group object to view a summary of active tapes grouped by 
data set name. 

To display summary of tapes by DSN group 

1. Open the Object Tree so it is showing the CA 1 objects as described in the section 
Use the GMI Windows Client GUI to Access CA 1 Objects (see page 83). 

CA 1 objects are displayed in the Object Tree. 
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2. Click the By DSN Group object in the Object Tree. 

The Table View of the Summary of Tapes By DSN Group object appears. The 
following is a sample of the Table View of the By DSN Group summary information. 

 
 

Summary of Tapes By Last Used Job Object 

The CA 1 summary of tapes By Last Used Job object shows a summary of active tapes 
grouped by the last jobname that used the tape (TMC field LJOB). The CA 1 TMC controls 
all of the tapes in the summary. The CA 1 Tape Volume unfiltered records provide input 
to this summary. 

 

This summary is organized by filters defined in the CA Vantage parmlib data set member 
FILTVIJO. Update member FILTVIJO to use the last used jobname groupings in effect at 
your site. 

 

For each group of tapes (as defined in <parmlibMember>), this object creates one 
summary record containing: 

■ Group name 

■ Number of tapes in the group 
 

■ Percent of the total the group represents 
 

■ Total allocated MB 

■ Average, minimum, and maximum allocated space for the tape in that group 
 

In addition, this table shows the average, minimum, and maximum values for the total 
number of: 

■ DSNBs on the selected tapes 

■ Opens for all the tapes in the group 

■ Tape blocks on all the tapes in the group 
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Display By Last Used Job Object 

You can display the By Last Used Job object to view a summary of active tapes grouped 
by the last jobname that used the tape (TMC field LJOB). 

To display a CA 1 summary of tapes by last used job 

1. Open the Object Tree so it is showing the CA 1 objects as described in the section 
Use the GMI Windows Client GUI to Access CA 1 Objects (see page 83). 

CA 1 objects are displayed in the Object Tree. 
 

2. Click the By Last Used Job object in the Object Tree. 

The Table View of the Summary of Tapes By Last Used Job object appears. The 
following is a sample of the Table View of the By Last Used Job summary 
information. 

 
 

Summary of Tapes By Tape RobotID Object 

The CA 1 summary of tapes By Tape RobotID object shows a summary of active tapes 
grouped by the ROBID field in the CA 1 TMC. You should contact your storage 
administrator or systems programmer to update the ROBID field in the TMC (for 
example, by using the TMSUPDTE utility) to make use of the summary group function. 
The CA 1 TMC controls all of the tapes in the summary. The CA 1 Tape Volume unfiltered 
records provide input to this summary. 

 

This summary is organized by filters defined in the CA Vantage parmlib data set member 
FILTVIRO. Update member FILTVIRO to use the tape robotID groupings in effect at your 
site. 
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For each group of tapes (as defined in <parmlibMember>), this object creates one 
summary record containing: 

■ Group name 

■ Number of tapes in the group 
 

■ Percent of the total the group represents 
 

■ Total allocated MB 

■ Average, minimum, and maximum allocated space for the tape in that group 
 

In addition, this table shows the average, minimum, and maximum values for the total 
number of: 

■ DSNBs on the selected tapes 

■ Opens for all the tapes in the group 

■ Tape blocks on all the tapes in the group 
 

Display By Tape RobotID Object 

You can display the By Tape RobotID object to view a summary of active tapes grouped 
by the ROBID field in the CA 1 TMC. 

To display CA 1 summary of tapes by tape robotID 

1. Open the Object Tree so it is showing the CA 1 objects as described in the section 
Use the GMI Windows Client GUI to Access CA 1 Objects (see page 83). 

CA 1 objects are displayed in the Object Tree. 
 

2. Click the By Tape RobotID object in the Object Tree. 

The Table View of the Summary of Tapes By Tape RobotID object appears. The 
following is a sample of the Table View of the By Tape RobotID summary 
information. 
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Summary of Tapes By Tape SMSMC Object 

The CA 1 summary of tapes By Tape SMSMC object shows a summary of active tapes 
grouped by the SMS Management Class field in the CA 1 TMC. The CA 1 TMC controls all 
of the tapes in the summary. The CA 1 Tape Volume unfiltered records provide input to 
this summary. 

 

This summary is organized by filters defined in the CA Vantage parmlib data set member 
FILTVIMC. Update member FILTVIMC to use the SMSMC groupings in effect at your site.  

 

For each group of tapes (as defined in <parmlibMember>), this object creates one 
summary record containing: 

■ Group name 

■ Number of tapes in the group 
 

■ Percent of the total the group represents 
 

■ Total allocated MB 

■ Average, minimum, and maximum allocated space for the tape in that group 
 

In addition, this table shows the average, minimum, and maximum values for the total 
number of: 

■ DSNBs on the selected tapes 

■ Opens for all the tapes in the group 

■ Tape blocks on all the tapes in the group 
 

Display By Tape SMSMC Object 

You can display the By Tape SMSMC object to view a summary of active tapes grouped 
by the SMS Management Class field in the CA 1 TMC. 

To display CA 1 summary of tapes by tape SMSMC 

1. Open the Object Tree so it is showing the CA 1 objects as described in the section 
Use the GMI Windows Client GUI to Access CA 1 Objects (see page 83). 

CA 1 objects are displayed in the Object Tree. 
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2. Click the By Tape SMSMC object in the Object Tree. 

The Table View of the Summary of Tapes By Tape SMSMC object appears. The 
following is a sample of the Table View of the By Tape SMSMC summary 
information. 

 
 

Summary of Tapes by Tape OUTCode Object 

The CA 1 summary of tapes By Tape OUTCode object shows a summary of active tapes 
grouped by the TMC OUTCODE field (also referred to as the Vault). The CA 1 TMC 
controls all of the tapes in the summary. The CA 1 Tape Volume unfiltered records 
provide input to this summary. 

 

This summary is organized by filters defined in the CA Vantage parmlib data set member 
FILTVIOU. Update member FILTVIOU to use the OUTCode groupings in effect at your 
site. 

 

For each group of tapes (as defined in <parmlibMember>), this object creates one 
summary record containing: 

■ Group name 

■ Number of tapes in the group 
 

■ Percent of the total the group represents 
 

■ Total allocated MB 

■ Average, minimum, and maximum allocated space for the tape in that group 
 

In addition, this table shows the average, minimum, and maximum values for the total 
number of: 

■ DSNBs on the selected tapes 

■ Opens for all the tapes in the group 

■ Tape blocks on all the tapes in the group 
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Display By Tape OUTCode Object 

You can display the By Tape OUTCode object to view a summary of active tapes grouped 
by the TMC OUTCODE field. 

To display CA 1 summary of tapes by tape OUTCode 

1. Open the Object Tree so it is showing the CA 1 objects as described in the section 
Use the GMI Windows Client GUI to Access CA 1 Objects (see page 83). 

CA 1 objects are displayed in the Object Tree. 
 

2. Click the By Tape OUTCode object in the Object Tree. 

The Table View of the Summary of Tapes By Tape OUTCode object appears. The 
following is a sample of the Table View of the By Tape OUTCode summary 
information. 
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